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THE NASA STI PROGRAM OFFICE . .. IN PROFILE

Since its founding, NASA has been
dedicated to the advancement of aeronautics
and space science. The NASA Scientific and
Technical Information (STI) Program Office
plays a key part in helping NASA maintain
this important role.

The NASA STI Program Office is operated
by Langley Research Center, the lead center
for NASA’s scientific and technical
information. The NASA STI Program Office
provides access to the NASA STI Database,
the largest collection of aeronautical and
space science ST1 in the world. The Program
Office is also NASA’s institutional
mechanism for disseminating the results of
its research and development activities.
These results are published by NASA in the
NASA STI Report Series, which includes
the following report types:

» TECHNICAL PUBLICATION. Reports
of completed research or a major
significant phase of research that present
the results of NASA programs and
include extensive data or theoretical
analysis. Includes compilations of
significant scientific and technical data
and information deemed to be of
continuing reference value. NASA’s
counterpart of peer-reviewed formal
professional papers but has less stringent
limitations on manuscript length and
extent of graphic presentations.

« TECHNICAL MEMORANDUM.
Scientific and technical findings that are
preliminary or of specialized interest,
e.g., quick release reports, working
papers, and bibliographies that contain
minimal annotation. Does not contain
extensive analysis.

+ CONTRACTOR REPORT. Scientific
and technical findings by NASA-
sponsored contractors and grantees.

+ CONFERENCE PUBLICATION.
Collected papers from scientific and
technical conferences, symposia,
seminars, or other meetings sponsored or
cosponsored by NASA.

« SPECIAL PUBLICATION. Scientific,
technical, or historical information from
NASA programs, projects, and mission,
often concerned with subjects having
substantial public interest.

«  TECHNICAL TRANSLATION.
English-language translations of foreign
scientific and technical material pertinent
to NASA’s mission.

Specialized services that complement the
STI Program Office’s diverse offerings
include creating custom thesauri, building
customized databases, organizing and
publishing research results . . . even
providing videos.

For more information about the NASA STI
Program Office, see the following:

»  Access the NASA STI Program Home
Page at http://www.sti.nasa.gov

»  E-mail your question via the internet to
help@sti.nasa.gov

» Fax your question to the NASA Access
Help Desk at (301) 621-0134

» Telephone the NASA Access Help Desk
at (301) 621-0390

*  Write to:
NASA Access Help Desk
NASA Center for AeroSpace Information
7115 Standard
Hanover, MD 21076-1320
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1. Introduction

The Debris Assessment Software (DAS) is provided by the NASA Orbital Debris Program Office
as a means of assessing, during the planning and design phase, space missions’ compliance with
NASA’s requirements for reduction of orbital debris.

1.1 Scope and Limitations

DAS is designed to assist NASA programs in performing orbital debris assessments (ODA), as
described in NASA Technical Standard 8719.14A, Process for Limiting Orbital Debris. The
software reflects the structure of the Standard and provides the user with tools to assess compliance
with the requirements. If non-compliant, DAS may also be used to explore debris mitigation
options to bring a program within requirements.

While DAS provides many functions useful in performing ODAs, its list of features is not
exhaustive. Some analyses (e.g., hardware reliability) are better done outside DAS. The user
should remember that DAS is a software tool, while the NASA Technical Standard 8719.14A
contains the actual mission requirements.

DAS 2.1 will assess payloads operating from the year 2010 to 2035, and objects in orbit (non-
operational) from 2010 to 2070. The time limits are based on the limits of the orbital debris
environment model, ORDEM 3.0. The small-object environment (objects with sizes <10 cm),
which is required for assessment of Requirement 4.5-2, ends in the year 2035. The larger-object
environment (sizes >10 cm), required for collision risk assessment during both operational and post-
mission phases, is projected to 2070. As a result, DAS 2.1 cannot assess Requirement 4.5-2 for
payloads still operational after 2035.

1.2 Software Changes

DAS 2 uses all-new computer code while building on the features of previous DAS versions. Minor
revisions to DAS 2 provide bug-fixes, important clarifications, and updated documentation, but do
not change the features of the software.

1.2.1 Changes from DAS 1.5.3 to DAS 2.0

The release of NASA’s Debris Assessment Software (DAS) version 2.0 provides an all-new tool for
mission designers to assess their mission’s compliance with NASA’s requirements for limiting
orbital debris. Updated models and methods make the new DAS more useful, and a Microsoft
Windows user interface makes it much easier to use.

DAS 2.0 includes updated propagators, environment models, and a reentry-survivability model.
The “fast” propagator used by DAS 1.5.3 has been replaced by NASA’s newer propagators,
“PROP3D” and “GEOPROP.” These are the propagators used by NASA’s debris environment



evolutionary models. Although they take longer to run, the new propagators produce more realistic
results. Improved force models include Earth’s atmosphere and gravitational field, solar and lunar
gravitation, and solar radiation pressure. The solar flux value (used for atmospheric drag
calculations) is no longer a user input; the user now enters the date, and the appropriate values are
retrieved from a model based on NOAA short-term predictions and NASA long-term predictions.
(Periodically updated solar flux tables should be obtained from the Orbital Debris Program Office
Web site.) The debris environment has also been updated from the previous “ORDEM96” model to
the newer “ORDEM2000.”

Numerous upgrades have been applied to the assessment of human casualty due to reentering
debris. Routines based on NASA’s Object Reentry Survival Analysis Tool version 6 determine
which objects may survive reentry, and the resulting risk of casualty is calculated based on an
updated world population database. Improvements to the model include the specification of orbital
inclination, an improved aero-heating model, temperature-dependent material properties (for the
included materials), and improved impact kinetic energy calculation. Up to 200 unique hardware
components may now be entered into up to four nested levels. This last feature allows the software
to more accurately model components which are exposed below the initial breakup altitude.

DAS 2.0 also includes a new native Microsoft Windows graphical user interface (GUI), which is a
vast improvement over the old DOS-based interface. The user enters detailed information about
each of their launched objects into the Mission Editor. This information is then available to the
various assessment modules, without having to be reentered. Some modules, most notably the
assessment of reentry survivability, require additional information to be entered by the user. For
ease of use, the entered information may be saved and reloaded from .csv (comma-separated values)
text files. In addition to the assessment modules, DAS still has a number of Science and
Engineering modules to assist in the assessment process. DAS 2.0 also includes on-line help
features familiar to Windows users.

1.2.2 Changes to DAS 2.0

DAS version 2.0.1 fixes an error in two material properties and a bug that resulted in incorrect
rocket body mass and A/M data being transferred from the Mission Editor to the assessment
routines for Requirements 4.7-1 and 4.8-1.

DAS version 2.0.2 fixes a number of errors that resulted in an incomplete assessment of some orbits
and inconsistencies between modules. A new software packager/installer works on all current
versions of Microsoft Windows. For a full description of the changes, please refer to the text file
“DAS202 release notes.txt” in the installed DAS directory.

1.2.3 Changes from DAS 2.0 to DAS 2.1
DAS version DAS 2.1 incorporates the orbital debris environment model of ORDEM 3.0, the

Orbital Debris Engineering Model also developed by the NASA Orbital Debris Program Office.
This is the only major change in this version.



IMPORTANT NOTE TO USERS: The higher-fidelity ORDEM 3.0 has greatly increased run-

times compared to the previous ORDEM?2 (a.k.a. ORDEM2000). Because DAS performs an
ORDEM analysis for each year an object is in orbit, these increased run-times are multiplied.

DAS runs that formerly took a few minutes will now take substantially longer.

During lengthy calculations, DAS may not respond and Windows may display the “Not
Responding” label and faded DAS window. DAS continues to run and will display results when the
computations are complete.

1.3 Software Installation and Removal

Recommended system for DAS 2.1:

Windows 7

1GHz+ Intel (or compatible)

256MB+ RAM

2 GB available disk space

CD-ROM drive (optional)

Windows Help software (https://support.microsoft.com/en-us/kb/917607)

Software Installation:

DAS 2.1 is distributed as an executable setup file. The setup will install the program’s executable
file and all necessary support files within the appropriate directories. The install program will
analyze the computer’s existing operating system to identify required support elements for
installation. The installation program will prompt for the following information:

1.

The Welcome window verifies that the installation of DAS 2.1 is desired at this time. If not,
select cancel.

The Software License Agreement verifies that the user agrees to accept the software’s
license. Disagreement will halt the installation. Agreement will proceed to the next step.

Choose Install Location defines the default location where the application will be installed.
A “Browse” button enables the user to view the file structure to define an alternative
location. DAS must be installed in a location to which the user has both read and write

permissions.

Choose Start Menu Folder defines a folder within the Windows Start->Programs list
where the application shortcuts will be stored. The default setup will be provided but
another name can be defined or an existing program folder can be selected where this
application will be loaded.

Installing shows the progress as the software and data files are uncompressed and installed.



6. A pop-up dialog reminds the user to download and install the Microsoft Windows Help
program from the Web site https://support.microsoft.com/en-us/kb/917607.

7. Installation Complete notifies the user that the setup has completed. The computer will not
require rebooting.

8. The Completing window gives the user the option to create a Windows Desktop shortcut
for DAS, and to display the Release Notes for this version.

DAS 2.1 does not update the internal Help function, which uses an old Windows Help format. If
the user’s system cannot open the DAS Help, the user must install the appropriate version of the
Windows Help program for their system. This is a free download from
https://support.microsoft.com/en-us/kb/917607.

Do not remove or rename files and directories installed with DAS 2.1. Do not modify files
within the DAS data directory (“[DAS]\data\”). Files and directories may be copied to another
location if necessary, but DAS requires the files as originally installed. The one exception is the
solar flux input table (file “[DAS]\data\solarflux table.dat’), which is updated periodically. It
should be replaced when a new version is posted on the Orbital Debris Program Office Web site.

Because DAS stores some session information in the Windows Registry, the software may not
behave as expected if the user installs multiple versions on the same computer. It is recommended
that previous versions of DAS be removed as part of the installation process.

Software Removal:

DAS 2.1 includes an automatic removal (‘“un-installer”) feature (DAS21-uninstall.exe), which is
found in the installed directory. There is also a shortcut to the un-installer in the Windows Start
Menu folder created during DAS installation. To remove DAS 2.1, activate the automatic un-
installer either through the Start Menu shortcut or directly.

Alternatively, the user may use the Windows Control Panel “Add or Remove Programs” feature to
remove DAS. From the Windows Start Menu, select Settings = Control Panel. In the Control
Panel, double-click on “Add or Remove Programs.” This brings up a window listing the installed
programs, including DAS (“Debris Assessment Software”). Highlight the entry for DAS, click
“Change/Remove,” and click “Yes” when asked to confirm removal. You may still need to
manually delete some files or folders from the directory where DAS was installed.



2. DAS Main Window Features

The DAS main window contains the top-level menus and toolbars, and a working area for the
various DAS dialog windows.

1

R‘ DAS - pru]lec! |; |§ E

File Edit Wiew indow Help

How k@

=l @ &

Mission Editor Requirement Assessments Science and Engineering

For Help, press F1 l_ v
Figure 2 - 1: DAS 2 Main Window

2.1 Viewing Toolbars

DAS 2 provides two forms of toolbars to add convenience for application functions. The toolbars
toggle on and off by selecting the items from the View menu.



Run Toolbar contains buttons for easy navigation between the major dialogs:

2] O
Missﬁimr Mission Editor
Py
@c’:- Requirement Assessment

Requirement Assessments

&

Science and Engineering

Science and Engineering

Toolbar contains buttons for the following commands:

&

The disk button on the Toolbar saves the project to file (File=>Save Project)

The print button prints the Activity Log. The print button (File->Print) is only available

when viewing the Activity Log.

2

Context-Sensitive help is available by clicking this button, then clicking on the item in

question. The cursor changes to this icon when context-sensitive help is engaged.

)

B¢
]
=

The database button launches the Material Database Editor (Edit->Material Database).
The plot button launches the Plot Utility (View=>View Plots).
The log button launches the Activity Log (View=>Activity Log-> View).

The calendar button launches the Date Conversion Utility (View->»Date Converter).



2.2 Using the Mission Editor

The Mission Editor is the starting point for assessing a mission’s compliance with NASA Technical
Standard 8719.14A, Process for Limiting Orbital Debris. The Mission Editor dialog (Fig. 2-2)
allows users to define spacecraft, rocket bodies, and mission-related debris for requirement
assessment. Launch year, mission duration, orbital characteristics, and many other items are
specified within this window, thus eliminating the need for re-declaring them in each of the
following requirement assessment windows.
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Figure 2 - 2: DAS 2 Mission Editor Dialog

The Mission Editor window has three main editing areas: two edit fields at the top of the window
(Mission Name and Launch Year), the Mission Components view, and the editable Define
Components Properties table at the bottom of the window. These areas are defined below with
specifics regarding each and also information regarding the two buttons “Apply Changes” and
“Reject Changes.”



Mission Editor Fields:

e Mission Name — This is a text field that holds the name of the mission that is being
assessed.

e Launch Year — This field specifies the year the mission is planned to start. The year can be
specified in decimal format. All years in orbit should fall between the years 2010 and 2070.
This limit is enforced to ensure that the calculation models can provide accurate estimates.

e Mission Components — A tree structure provides a quick look at all defined components of
the mission. It is broken into three categories: payloads, rocket bodies, and mission-related
debris. Each of these categories has different specifications for its components. When
selecting an item, the grid area below the tree structure will change to reflect the properties
of that type of component. Also, the individual item in the tree will be highlighted within
the grid for quick reference or editing.

e Define Component Properties Grid — This area is for defining and editing all the
properties of each of the three categories of components. As mentioned above, there are
three categories of components (payloads, rocket bodies, and mission-related debris). Each
has its own set of properties, so selection of one type will only show components of that
type. At the bottom of this grid is an empty row that can be used for adding new
components. There is also a right mouse button menu available (click with the right mouse
button on the table) for adding, deleting, or ordering of components.

Upon completion of editing component data, the user should press the “Apply Changes”
button. This will validate all the changes and save the data for later use in the requirement
assessments. If the user wishes to abort changes since their last “Apply Changes” action,
pressing the “Reject Changes” button will discard the changes. Each of these three category
tables has different property fields and their descriptions and constraints are listed below.

Important Note: In DAS 2, highlighting a text field is NOT the same as selecting the field. When
a text field is highlighted, it is ready for input from the keyboard. The “highlight” may be moved
using the arrow keys or a single mouse-click. A highlighted field is not, however, ready for cut-
and-paste operations. To select a field for cut, copy, or paste, the user must first highlight the field
(using arrow keys or mouse), then click the mouse in the already-highlighted field. This will place
a standard text cursor in the field. The user may then select the text within the field, and use the
standard cut/copy/paste operations.



Payloads:

Table 2 - 1: Mission Editor, Payload Grid

Payload Name

Payload Name is the unique identifier for each payload, and it must
be distinct from all other component names.

Mission Duration
(yn

Mission Duration is a field that specifies the desired lifetime of the
payload beginning from the Launch Year. Itis a decimal field
(allowing partial years to be specified). This numeric value must be
greater than zero.

Operational Operational Perigee Altitude is measured from Earth’s surface to

Perigee Alt (km) | the spacecraft’s normal, operational orbit perigee point. This
decimal value must be greater than 90 and less than or equal to
100,000 kilometers. Operational Perigee Altitude must be less than
or equal to Operational Apogee Altitude.

Operational Operational Apogee Altitude is the distance measured from Earth’s

Apogee Alt (km) | surface to the spacecraft’s normal, operational orbit apogee point.
This decimal value must be greater than 90 and less than or equal to
100,000 kilometers. Operational Apogee Altitude must be greater
than or equal to Operational Perigee Altitude.

Operational Operational Inclination is the angle measured from Earth’s

Inclination (deg)

equatorial plane to the payload’s operational orbital plane. This
decimal value must be between 0 and 180 degrees.

RAAN (deg)

Right Ascension of Ascending Node is a decimal value between

0 and 360 degrees. RAAN is only needed if the apogee altitude is
greater than 2000 km. The field will remain inactive until an
apogee altitude greater than 2000 km is entered.

Argument of
Perigee (deQ)

Argument of Perigee is a decimal value between 0 and 360 degrees.
This value is only needed if the apogee altitude is greater than

2000 km. The field will remain inactive until an apogee altitude
greater than 2000 km is entered.

Mean Anomaly
(deg)

Mean Anomaly is a decimal value between 0 and 360 degrees.
Mean Anomaly is only needed if the apogee altitude is greater than
2000 km. The field will remain inactive until an apogee altitude
greater than 2000 km is entered.

PMD Maneuver
(check if Yes)

Postmission Disposal Maneuver is a check box entry. Placing a
check in the box indicates a planned disposal maneuver in space.
A check in this field will enable the disposal orbital parameter
fields of the grid.

Disposal Perigee
Alt (km)

Perigee Altitude for postmission disposal orbit is a decimal value
that must be greater than 90 and less than or equal to

100,000 kilometers. Perigee altitude must be less than or equal to
apogee altitude.

Disposal Apogee
Alt (km)

Apogee Altitude for postmission disposal orbit is a decimal value
than must be greater than 90 and less than or equal to

100,000 kilometers. Apogee altitude must be greater than or equal
to perigee altitude.




Table 2 - 1 - Continued

Disposal Inclination for postmission disposal orbit is a decimal value that
Inclination (deg) | must be between 0 and 180 degrees.

Disposal RAAN | RAAN for postmission disposal orbit is a decimal value that must
(deg) be between 0 and 360 degrees. RAAN is only needed if the

disposal apogee altitude is greater than 2000 km. The field will
remain inactive until a disposal apogee altitude greater than
2000 km is entered.

Disposal Arg of
Perigee (deQ)

Argument of Perigee for postmission disposal orbit is a decimal
value that must be between 0 and 360 degrees. Argument of
Perigee is only needed if the disposal apogee altitude is greater than
2000 km. The field will remain inactive until a disposal apogee
altitude greater than 2000 km is entered.

Disposal Mean
Anomaly (deg)

Mean Anomaly value for postmission disposal orbit is a decimal
value that must be between 0 and 360 degrees. Mean Anomaly is
only needed if the disposal apogee altitude is greater than 2000 km.
The field will remain inactive until a disposal apogee altitude
greater than 2000 km is entered.

Initial Mass (kg)

Initial Mass is a decimal field for the mass of the payload (in
kilograms) at the start of the mission in the operational orbit,
including all fluids and all internal fragments (aero mass).

Final Mass (kg)

Final Mass is a decimal field representing the mass of the payload
(in kilograms) after the payload’s mission and all postmission
passivation actions are completed. This should be the dry aero
mass of the payload if all fluids have been expended.

Final Area-To-
Mass (m? /kg)

Final Area-To-Mass is a decimal field representing the average
cross-sectional area of a payload (in square meters) divided by the
final mass of the payload (in kilograms).

Station Keeping
(check if Yes)

Station Keeping is a check box field. If checked, the payload’s
orbital elements are fixed throughout its mission duration. During
its mission duration, the payload is precluded from natural orbital
decay by active station keeping devices, e.g., thrusters. DAS 2
assumes that if an object is “Station Kept,” the user input orbital
elements will not be subject to decay. Objects that are not station
kept will be assumed to decay naturally throughout their lifetime.

Planned Breakup
(check if Yes)

Planned Breakup is a check box field. If checked, the payload will
be broken apart (exploded) as part of its postmission disposal. The
breakup is assumed to occur on the descending leg of the orbit
revolution, i.e. at or approaching perigee.
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Rocket Bodies:
Table 2 - 2: Mission Editor, Rocket Body Grid

Rocket Body Name | Rocket Body Name is the unique identifier for each rocket body
and it must be distinct from all other component names.

Perigee Alt (km) Perigee Altitude is measured from Earth’s surface to the rocket
body’s disposal orbit apogee point. This decimal value must be
greater than 90 and less than or equal to 100,000 kilometers.
Perigee altitude must be less than or equal to apogee altitude.
Apogee Alt (km) Apogee Altitude is measured from Earth’s surface to the rocket
body’s disposal orbit perigee point. This decimal value must be
greater than 90 and less than or equal to 100,000 kilometers.
Apogee altitude must be greater than or equal to perigee altitude.

Inclination (deg) Inclination of the disposal orbit with respect to Earth’s equatorial
plane. This decimal value must be between 0 and 180 degrees.
RAAN (deg) Right Ascension of Ascending Node is a decimal between 0 and

360 degrees. RAAN is only needed if the apogee altitude is
greater than 2000 km. The field will remain inactive until an
apogee altitude greater than 2000 km is entered.

Argument of Argument of Perigee value is a decimal value between 0 and
Perigee (deQ) 360 degrees. This value is only needed if the apogee altitude is
greater than 2000 km. The field will remain inactive until an
apogee altitude greater than 2000 km is entered.

Mean Anomaly Mean Anomaly is a decimal value between 0 and 360 degrees.
(deg) This value is only needed if the apogee altitude is greater than
2000 km. The field will remain inactive until an apogee altitude
greater than 2000 km is entered.

Final Mass (kg) Final Mass is a decimal value representing the mass of the rocket
body (in kilograms) after the rocket body’s mission is complete
and after passivation.

Final Area-To- Final Area-To-Mass is a decimal value representing the average
Mass (m?2/kg) cross-sectional area of the rocket body (in square meters) divided
by the final mass of the rocket body (in kilograms).

Planned Breakup Planned Breakup is a check box field. If checked, the rocket body
(check if “Yes") will be broken apart (exploded) as part of its postmission
disposal. The breakup is assumed to occur on the descending leg
of the orbit revolution, i.e. at or approaching perigee.

Mission-Related Debris:
Mission-Related Debris items only need to be defined if they pass through Low Earth Orbit (LEO)

and are 1 mm or larger in size, or if they pass through geosynchronous orbit (GEO) and are 5 cm or
larger in size.
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Table 2 - 3: Mission Editor, Mission-Related Debris Grid

Debris Name

Debris Name is the unique identifier for this component and its
value must be distinct from all other component names.

Released Year

Released Year is a decimal value that defines the date that this
debris is released from the spacecraft or rocket body. This value
must be equal to or greater than the mission’s launch year.

Quantity of Each Quantity of Each Element is the number of debris items of this

Element type that will be released. It must have a value of one or greater.

Area-To-Mass Area-To-Mass is a decimal value for the average cross-sectional

(m?/kg) area of the debris (in square meters) divided by the mass of the
debris (in kilograms).

Perigee Alt (km) Perigee Altitude is measured from Earth’s surface to the debris
object’s perigee point. This decimal value must be greater than
90 and less than or equal to 100,000 kilometers. Perigee altitude
must be less than or equal to the apogee altitude.

Apogee Alt (km) Apogee Altitude is measured from Earth’s surface to the debris

object’s apogee point. This decimal value must be greater than
90 km and not exceeding 100,000 km. Apogee altitude must be
greater than or equal to the perigee altitude.

Inclination (deg)

Inclination of the debris object’s orbit; a decimal value between
0 and 180 degrees.

RAAN

Right Ascension of Ascending Node is a decimal value between
0 and 360 degrees. This value is only needed if the apogee
altitude is greater than 2000 km. The field will remain inactive
until an apogee altitude greater than 2000 km is entered.

Argument of
Perigee (deQ)

Argument of Perigee is a decimal value between 0 and

360 degrees. This value is only needed if the apogee altitude is
greater than 2000 km. The field will remain inactive until an
apogee altitude greater than 2000 km is entered.

Mean Anomaly
(deg)

Mean Anomaly is a decimal value between 0 and 360 degrees.
This value is only needed if the apogee altitude is greater than
2000 km. The field will remain inactive until an apogee altitude
greater than 2000 km is entered.
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2.3 Requirement Assessments

The Requirement Assessments window provides an adjustable split window to view the dialogs
for each requirement supported by DAS 2. The dialog contains a list of supported requirements in
the left window pane. As a requirement is selected, the supporting dialog will appear in the right
pane. Data entered into the Mission Editor serve as input data for the requirements, though
additional input may be required. As data are analyzed in each requirement, the compliance state is
displayed as an icon next to that label in the left window. Additional information appears in the
output area at the bottom of each requirement assessment window. If the mission is compliant with
a requirement, a green check icon will appear next to the requirement name. If the mission is not
compliant, a red “X” will appear. The user may use the mouse to adjust the position of the divider
between the left and right windows.

As data are input, requirements are assessed, and output is generated, the data will be retained
within the project’s data. It is saved to the project files when the user agrees to saving the data on
application termination, or selects the File=>Save Project command from the main menu.

Selecting various requirements only affects the current view in the right side of the window. The
information and state are retained as long as the requirement assessment window is open.
Assessment status is lost when the window is closed.

Changes within the Mission Editor can affect data used within the previously opened requirements.
When changes to mission data are applied within the Mission Editor, the Requirement
Assessments window is closed and all compliance states are reset.

All assessments can be reset to initial state (not run) by depressing the “Reset” button in the right
window pane displayed with the upper requirement level (NASA-STD-8719.14A, Process for
Limiting Orbital Debris).

Chapter 3 provides details of each assessment’s operations.
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Figure 2 - 3: Requirement Assessments Top-level Dialog

2.4 Science and Engineering Utilities

The Science and Engineering Utilities allow the user to analyze some aspects of orbit/mission design
outside the context of Requirement Assessments.

To access each tool, expand a category from the tree and then double-click the mouse over the selected
routine. The corresponding dialog will appear.

Chapter 4 provides details of the Science and Engineering Utilities.
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2.5 Using the Material Database Editor

Reentry assessment requires information on the type of material used in an object’s construction. The
Material Database provides a view of standard materials used by the underlying application and a means
to define additional materials specific to a mission. See Appendix C for a table of properties of the
standard materials.

If an object uses a material that is not on the standard list, user-defined materials may be created
specifically for the current project, defining:

e Density

e  Specific heat

e Heat of fusion

e Melt temperature

Note that material density is only used as a “sanity check” (i.e. limiting case) on user inputs of mass and
size. It is used to verify that the data input for an object’s mass and dimensions are consistent.

The Material Database dialog can be opened to view the defined data or add user-defined materials by

pressing the database button & on the Toolbar or selecting Edit->Material Database from the
application menu.

Newly defined materials are saved to the project\matprop.csv file by pressing the “Save” button.

Closing the dialog without saving updates will prompt the user to save.

2.6 Using the Plot Viewer

DAS includes a two-dimensional plot viewing utility. To activate the plot utility, press the plot viewer

button pe on the Toolbar, or select View->View Plots from the application menu. The DAS Plot
window will open containing a blank two-dimensional plot layout. The plot window will also be
generated by functions in the Science and Engineering utilities.

The utility provides the following buttons to manage plot files:

e Load Plot - Displays an Open Plot File dialog to navigate to a previously saved *.dpl file to be
loaded into the display area of the Plot Utility.

e Save Plot —Provides a Save Plot dialog to specify the name and directory location for the saved
*.dpl file. The dialog defaults to the “My Documents” directory.

e Copy to Clipboard — Copies the plot image to the Windows clipboard. An acknowledgement
dialog will appear, requiring an “OK” to proceed. The image may then be pasted into other
(non-DAS) applications.
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Close — Closes the Plot Utility. Be certain that all desired changes have been saved before
closing the window since no save prompt will remind the user before closing the window.

A single right-mouse or double left-mouse click on the plot area (left window pane) will display a pop-
up menu with additional plotting functionality:

Select — Allows users to select objects with the mouse. Select returns the cursor state to a
pointed arrow and turns off other cursor functions (Zoom, Pan, Cursor).

Zoom — Allows users to isolate and enlarge a rectangular area of the plot. The cursor changes to
a cross-hair (+). By holding the left-mouse button while dragging the cross-hair over the plot,
a rectangular highlight area appears. Size the rectangle by maneuvering the mouse over the plot.
Releasing the mouse button enlarges the highlighted rectangular area. The axes adjust to the
zoomed size.

Reset — Allows users to reset all axes to optimal values.

Pan — Allows users to move the plotted curve(s) within the plot area. The cursor changes to the
pan cursor (+f). The cursor can be moved by holding the left-mouse button while dragging the
cursor over the plot. The axes scale to fit the pan. To stop the action, release the mouse. To
leave Pan mode, right-click on the plot and choose “Select” from the pop-up menu.

Cursor — Provides the means to capture the mouse’s position on the plot, interpolating the
mouse coordinates to the corresponding plot scale. The cursor changes to a cross-hair ( +), and
one vertical and one horizontal line intersect marking the cursor’s position. Clicking the left-
mouse button inserts a label onto the graph with the interpolated values. Clicking the right-
mouse button launches the pop-up menu. Choose “Select” from the pop-up menu to change the
cursor back to a pointing arrow. To remove the labels from the graph, return to Select mode,
click the left-mouse button over the desired label object, noting that the item has been activated,
and then depress the “Delete” key on the keyboard.

Insert Label — Inserts a blank label (text box) onto the plot. Click the left-mouse button on the
label until the object is activated, and then double-click the left mouse button within the label.
This action should change the cursor to a vertical text cursor within the label. Once the cursor
changes, begin typing or paste any previously copied text. The label can be moved and sized by
manipulating the mouse after activating the label. When the object is activated, additional
functionality becomes available. Clicking the right-mouse button within the activated label
launches a label properties dialog box:

o Background color — Launches a color palette for selecting and changing background
color.

o Font - Launches a common Font dialog.
o Alignment — Provides a means to align the text Left, Centered or Right.

o Connect to curve — Combo box allows users to choose to which curve the label will be
attached,

o Transparent and Border check boxes — Provide optional label bordering.
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Labels in the plot area may be selected with a single left-mouse click. Once selected, a label
may be moved, resized, activated (for editing), or deleted. This applies to both user-inserted
labels and to automatic labels (such as the plot title).

Print — Provides a means to print an active plot to a designated printer by selecting printer
characteristics and functions from a print dialog window. Currently, only grayscale printing is
available; however, plots copied to another application (e.g., word processor) can be printed
based on that application’s print support.

Properties — Opens a dialog to set various properties for the displayed plot. Once properties are
changed, click “Apply” (immediately apply changes and leave dialog open) or “OK” (apply
changes and close dialog) to activate the changed properties. “Cancel” will close the dialog
without applying any selected changes. The three tabbed sets of property categories are:

o Chart — Has nine controls that offer additional features for changing the way the plot is
displayed
= Background color — Dialog that allows users to set the color outside the plot area
and labels.

= Exterior color — Dialog that allows users to set the color behind the axes and the
color of the grid lines on their plot.

= Interior color — Dialog that allows users to set the color of the plot inside the
axes.

= Show Legend — Position the legend to either the left or right of the plot, or
remove it.

= Snap Cursor to nearest curve — Position the cursor to the curve within a
specified tolerance (up to 100 pixels).

= Select x-axis — Applies the x-axis properties on the Axis property dialog.
Leaving the field blank selects the y-axis.

= Select y-axis — Applies the y-axis properties on the Axis property dialog.
Leaving the field blank selects the x-axis.

= Select curve — Selects a specific curve’s properties on the Curve property dialog.

= Double Buffering — Turns double buffering either on or off. Double buffering
can improve the appearance of moving images (pan and zoom).

o Axis — properties allow users to modify various axis features such as scale, tick-size,
font, and grid color. Once choices have been completed for each axis, depress “Apply”
or “OK” to process the changes.

o Curve — properties allow users to modify various curve features such as line width, line
color, curve trends, and marker size. For each curve, depress “Apply” or “OK” to
process the selected changes.
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2.7 Using the Date Conversion Utility

The Date Conversion Utility is provided for easy conversion between the following date formats:

e Calendar Format — The year, month and day can be selected in the calendar control. The user
may select another month by pressing the previous (left) or next (right) arrow buttons within the
calendar title, or by clicking on the name of the month. To select another year, click on the year
within the title and then roll forward (up) or back(down) using the control that will appear next
to the year. The day selected within the lower calendar will remain selected for the changed
year or month.

e Decimal Date — The format for decimal date is: yyyy.ddd, where ddd is the decimal portion of
the year, i.e. June 30, 2006 is formatted as “2006. 496, or November 15, 2005 is formatted as
“2005.874”.

e Day of Year — The format for day of year is yyyy doy, where doy is the numeric day within the
year’s days (365, 366). For example: June 30, 2006 is formatted as “2006 181, and November
15, 2005 is formatted as “2005 319”.

Activate the Date Conversion Utility by pressing the calendar button = on the Toolbar, or by
selecting View->Date Converter from the application menu. As a date is entered within any control,
that date will be displayed in the other controls in the control’s supported format.

2.8 Viewing the Activity Log

The Activity Log provides a means to view all data processed within the DAS 2 application. As
requirements are assessed, the data input and the resulting output are written to the Activity Log. The
data are written to the file ActivityLog in the application’s directory. The file can be used to track a
problem with data, or to capture text based on the project being defined.

As the program starts, the previous ActivityLog file is over-written. To save a copy of the current
ActivityLog file to an alternate location, select File=>Save Log As... from the application menu. The
file can be viewed outside DAS 2 in text editor/viewer (e.g., WordPad or Word) and printed using
File=>Print Setup, File=>Print Preview and File=>Print.

The Activity Log can be cleared during processing by selecting View-> Activity Log->Clear from the
application menu. This function can be used to reduce the amount of data viewed during processing
without changing the underlying text saved in the log file.

Previously cleared views of the Activity Log can be restored (to view all data processed since the
program started) by selecting the View=> Activity Log->Restore menu item.

The clear and restore functions do not affect the underlying ActivityLog file.
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2.9 Saving and Loading Projects

In DAS 2 all data are stored as a “project.” A project consists of a directory with many files that retain
all the data that the user may define within the application. The default project is a directory folder
named “project/” within the installed DAS directory.

Use the File->New Project menu function to create a new project. The Define New Project Path
dialog will appear for entering the path. A browse button (...) next to the path entry opens the Browse
for New Project Folder dialog to view the computer’s paths and select existing directories with defined
mapped paths. The dialog contains an edit control to enter the name of the new directory if it does not
already exist. When the OK button in either dialog is pressed, the directory will be created. If the
project directory already exists, DAS will prompt the user with a reminder that any previously saved
data in that directory will be replaced by the new project. The new project is opened in its initial (blank)
state. This action will then launch the Mission Editor so that a new mission may be defined.

To create a new project based on a currently open project, select the File->Save Project As... menu
item. Its function is similar to the New Project function except that any existing data is saved in the new
directory, including any updates applied since the project was opened or previously saved. If the project
directory already exists, DAS will prompt the user with a reminder that any previously saved data in that
directory will be replaced by the new project.

To open a project, select the menu item File=>Open Project. The Open Project dialog is similar to the
Define New Project Path dialog except that the browse dialog does not support the creation of new
directories and the Open Project dialog will verify that the selected directory contains the required
das.prj file. Aninvalid (incomplete) project directory will not open and the dialog will remain open.

As projects are opened, the path is saved and will appear on the File menu above the Exit item. Up to
four projects are collected as recently-used projects and will appear in the order referenced, with the
latest at the top. When the application opens, if the most recent project path is still valid, that project
will open instead of the initial default path.

The application does not retain updates to the project unless the user selects the File=>Save Project

menu item, presses the project save button = on the toolbar, or closes the application and chooses
“Yes” on the prompt to save their data. This allows the user the option to close without saving and
return to the last saved state.
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3. Assessing Compliance with the NASA Debris Requirements

The Requirement dialog contains a list of supported requirements in the left window (some
requirements must be assessed outside of DAS). As a requirement is selected, the supporting dialog
will appear in the right window. All data input into the requirement window will be retained until
the application closes. The result of the requirement assessment will appear as an icon next to that
label in the Requirements window.

As requirements are processed and output is generated, the information will be retained within the
project data. It will be saved to the project files when the user agrees to saving the data on
application termination.

Selecting various requirements only affects the current view in the right side of the window. The
data and state are retained as long as the requirement assessments window is open. Compliance
state is lost when the window is closed.

Changes within the Mission Editor can affect data used within the previously open requirements.
When changes to data are applied within the Mission Editor, the Requirement Assessments
window is closed and all states reset.

3.1 Requirement 4.3-1: Debris Passing Through LEO

For missions leaving debris in orbits passing through LEO, released debris with diameters of 1 mm
or larger shall satisfy both of the following conditions:

a. All debris released during the deployment, operation, and disposal phases shall be
limited to a maximum orbital lifetime of 25 years from date of release.

b. The total object-time product shall be no larger than 100 object-years per mission. The
object-time product is the sum over all debris of the total time spent below 2000 km
altitude (i.e. LEO dwell time) during the orbital lifetime of each object.

The intent of Requirement 4.3-1 is to remove debris in LEO from the environment in a reasonable
period of time. The 25-year removal time from LEO limits the growth of the debris environment
over the next 100 years while limiting the cost burden to programs and projects.

Debris in orbits with perigee altitudes below 600 km will usually have orbital lifetimes of less than
25 years. This requirement will have the greatest impact on programs and projects with perigee
altitudes above 700 km, where objects may remain in orbit for hundreds of years.

Requirement 4.3-1 applies to staging components, deployment hardware, and other objects that are

known to be released during normal operations. Spacecraft and launch vehicle stages are addressed
in other Requirements.
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— [Requirement 4.3-1] Debriz Pazzing thraugh LED

— Mizzion-R elated Debris in LED

Debris Released | Quantity of Area-To-Mass | Perigee | Apogee | Inclination |RAAM | Argument of | Mean Anomaly
Row | Mame Year Each Element | {m~2kag) AlE (k) | AlL (k) | (deqg) {deq) |Perigee (deg) | (deg)
1 Lens Cap 200515 |1 0.01564407 725 730 15
z2 Stage Bolks | 200515 3 0046 250 725 26.5
8 Straps 2005,15 2 0789 250 725 26.5

Bun Requiremnent Help
— Output
Debris Compliance Lifetime Object Time
Row | Mame Status {yrs) {obj-yrs)
1 Lens Cap Mon-Compliant 40,1 40.0
Z Stage Bolts Campliant 1.9 5.7
Straps Campliant o1 0.z

TOTAL OBJECT TIME:

|45.E| ohij yrz

—Meszages

Requirement 4.3-1
Mon-Compliant Bow: 1

MOTE: For Mon-Compliant Status - Refer to Help or Analyziz zection within Science and Engineering Utilities

Figure 3 - 1: Requirement 4.3-1 Debris Passing Through LEO Dialog

Input Data:

The data displayed in the input grid are “read-only.” To modify the input data, the user must return
to the Define Mission-Related Debris Properties grid of the Mission Editor.

Output Data:

Each debris object is assigned a compliance status. If any object is not in compliance, then the
mission does not comply with Requirement 4.3-1.

The total object time product (applies to Requirement 4.3-1b) is the sum, over all objects, of the
orbital dwell time in LEO. If the debris is in an orbit with apogee altitude below 2000 km, the orbit
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dwell time equals the orbital lifetime. The total object-time product should be no larger than
100 object-years per mission.

If the calculated LEO dwell time for a debris object is calculated to be 25 years, then no more than
four such objects can be released for the mission to be compliant with the 100 object-years limit of
Requirement 4.3-1b. Requirement 4.3-1a limits the total orbital lifetime of a single piece of debris
passing through LEO to 25 years, regardless of how much time per orbit is spent below 2000 km. If
the LEO dwell time of the debris is only 20 years, then a total of up to five debris objects can be
released and still satisfy Requirement 4.3-1b, as long as the maximum orbital lifetime of each object
does not exceed 25 years.

Messages and comments developed during analysis are displayed on the dialog, below the output
data.

3.2 Requirement 4.3-2: Debris Passing Near GEO

For missions leaving debris in orbits with the potential of traversing GEO (GEO altitude +/-200 km
and +/-15 degrees latitude), released debris with diameters of 5 cm or greater shall be left in orbits
which will ensure that within 25 years after release the apogee will no longer exceed GEO —

200 km.

Requirement 4.3-2 includes debris released by a spacecraft, such as solid rocket motor casings and
other objects that are known to be released during normal operations.

Mission-related debris passing near GEO, in general, can be categorized as in nearly circular or in
highly eccentric orbits. An example of a nearly circular orbit would be debris, e.g. a solid rocket
motor casing, released by a spacecraft after the spacecraft has already been inserted into an orbit
near GEO.

To ensure that the mission is compliant with Requirement 4.3-2, the spacecraft must be sufficiently
above or below GEO at the time of debris release.

Debris might also originate from a launch vehicle orbital stage which has directly inserted its
payload into an orbit near GEO. In such a case, all debris should be eliminated entirely or the
orbital stage should be sufficiently removed from the GEO regime at the time of debris release.

Debris might also be released into highly-eccentric geosynchronous transfer orbits (GTO) with
perigee altitudes within LEO or at higher altitudes and with apogee altitudes near or passing through
GEO. Debris released at the time of payload separation on a mission of this type would fall under
Requirement 4.3-2.

Debris can be left in an eccentric orbit traversing GEO, if orbital perturbations will cause the object
to leave the GEO regime within 25 years. DAS can be used to determine the long-term orbital
perturbation effects for specific initial orbital conditions and, hence, to determine compliance with
Requirement 4.3-2 by ensuring the debris will not reenter the GEO region within 100 years.
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Debris that are not removed from GEO altitude can remain in the GEO environment for many
thousands of years. Requirement 4.3-2 limits the accumulation of debris at GEO altitudes and will
help prevent the development of a significant debris environment, as currently exists in LEO. The
200 km offset distance (see requirement text) takes into account the operational requirements of

GEO spacecraft.

Special orbit propagation models are necessary to evaluate the evolution of disposal orbits to ensure

that debris do not later interfere with the GEO regime, as a result of solar and lunar gravitational

perturbations.

 Miszion-Related Debriz in GED

~ [Requirement 4.3-2] Debris Pazzing Near GED

Debris Released |Cuantity of | Area-To-Mass |Perigee | Apogee | Inclination |RAAMN | Argument of | Mean Anomaly
Row | Mame Vear Each Element | {m=2 ko) Al (kmd | AlE km) | (deaq) {deq) | Perigee {deqg) | {deq)
1 Solar Panel bolt | 2005 2 0997 35765 25769 0.1 il 1] il

Fequirement

Help

Debris

Compliance

Final Apogee

Inclination

Mame

Skaktus

(e}

Ideg)

14,301146

35867.070599

Man-Compliant

Solar Panel bol:

— Meszages

Fequirement 4.3-2
Mon-Compliant Bow: 1 - Debrig Still in T raffic Zone where Apogee exceeds GEOD - 200 km

MOTE: For Mon-Compliant Status - Refer to Help or Analysis section within Science and Engineering Utilities

Figure 3 - 2: Requirement 4.3-2 Debris Passing Near GEO Dialog
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Input Data:

The data displayed in the input grid is “read-only.” Input to the requirement is entered through the
Mission Editor under the Define Mission-Related Debris Properties grid.

Output Data:

Once processed, output is displayed in the output area of the dialog. Each debris object is assigned
a compliance status. If any object is not in compliance, then the mission does not comply with
Requirement 4.3-2.

Messages and comments developed during analysis are displayed on the dialog, below the output
data.

3.3 Requirements 4.4-1, 4.4-2, and 4.4-4: Not Covered by DAS

DAS 2 will not determine compliance with Requirements 4.4-1, 4.4-2, or 4.4-4. The project must
demonstrate compliance with Requirements 4.4-1 and 4.4-2 though its own calculations. For
Requirement 4.4-4, contact the JSC Orbital Debris Program Office for assistance.

3.4 Requirement 4.4-3: Planned Breakups

The objective of Requirement 4.4-3 is to understand and limit the impact of the debris contributions
from on-orbit tests on the space environment, specifically, long-term contributions to the orbital
debris environment. Orbital characteristics at breakup are given for the space structure and
estimates of the number, size, and lifetime of the generated orbital debris are returned.
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— [Requirement 4.4-3] Flanned Breakups

— Input
Pre-Breakup Pre-Breakup Breakup Altitude
Perigee alt (km) | Apogee Alk (kmd | (k)
Payload 1 Q00 1000 as0
Rocket Body 1 | 100 170 100
Rocket Body 2 | 150 160 160

Bun R equirement Help
— Output
Component | Compliance Chject Time (== 10cm) | Mumber of Debris (== 1 mm)
Type Skatus (obj-vyrs) with Liftime Crer 1 wr
Payload 1 Pavload Mon-Compliant | 235,64 330063
Rocket Body 1 | Rocket Body | Compliant 0,66 1]
Rocket Body 2 | Rocket Body | Compliant 0.65 1]

IESE Longest-Lived Object-Time Product [obj-yrz]

—Mezzages

R equirement 4.4-3: Mon-Compliant
Payload 1: Failed - 1 mm particle(z] in orbit 1 vear after breakup and 10 cm obj-time product exceeds 100 obj-yrs.

MOTE: For Mon-Compliant Status - Refer to Help or Analyzsis section within Science and Engineening Utiliies

Figure 3 - 3: Requirement 4.4-3 Planned Breakups Dialog
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Input Data:

Users specify pre-breakup perigee altitude, pre-breakup apogee altitude, and planned breakup
altitude for the space structure before running the assessment. Other required orbit elements are
entered into the Mission Editor. Only items checked as “Planned Breakup” in the Mission Editor
will appear in Requirement 4.4-3. Before assessment, the planned breakup altitude is checked to be
between the defined orbital perigee and apogee.

Note that the breakup is assumed to occur on the descending leg of the orbit revolution, i.e. at or
approaching perigee.

Output Data:

The output area of the dialog displays a table listed by component. Each component displays
compliance status: object-time product sum for debris larger than 10 cm and the number of debris
larger than 1 mm with a lifetime longer than a year.

Longest Lived Object-Time Product applies to Requirement 4.4-3. The total object-time product
for 10 cm debris should be no larger than 100 object-years per mission. The longest lived object-
time field gives the longest object-time product of all components. If this returned value exceeds
100 object years, then the mission is non-compliant.

Component(s) that fail this requirement should be brought into compliance. Each component must
have no debris larger than 1 mm in orbit longer than one year.

Messages and comments developed during analysis are displayed on the dialog, below the output
data.

3.5 Requirement 4.5-1: Limiting Debris Generated by Collisions with Large
Objects

Catastrophic collisions during orbital lifetime represent a direct source of debris, and the probability
of this occurring is addressed by Requirement 4.5-1. This Requirement limits the amount of debris
created by collisions between spacecraft or launch vehicle orbital stages in or passing through LEO
and other large objects in orbit. By limiting the probability of collision between a spacecraft or
orbital stage and other large objects to less than 0.001, the average probability of an operating
spacecraft colliding with collision fragments larger than 1 mm from the subject spacecraft or orbital

stage will be less than 107° per “average spacecraft.”

26



— [Requirement 4.5-1] Limiting D ebris Generated by Collisions with Large Objects

—Input
Start Year |2DDE
Space Perigee fpogee | Inclination RLAAN Argument of Mission Final Area-To-Mass Final
Skructure (k) (k) {deg) (deq) Perigee (deq) | Duration {yrs) | Ratio {m™2fka) Mass(kg)
Dassat 1 Payload 75 75 10,3 25 1656 425
First Stage ... |Rockey Body 200 725 26.5 .014 200
Second Sta,.. |Rockey Body sz} 7E5 103 .07a 100

Bun Requirment Help
— Dutput
Space Compliance Collision
Skructure Status Probability
Dassat 1 Pavioad Compliant 0.00045
Firsk Stage ... |Rocket Body Compliant 0.00032
Second Sta,.. |Rocket Body Compliant 00001z

—Meszage:

Reguirement 4.5-1: Compliant - DasSat 1
Reguirement 4.5-1; Compliant - Firzt Stage R/B

Requirement 4.5-1: Compliant - Second Stage RAY

Figure 3 - 4: Requirement 4.5-1 Limiting Debris Generated by Collisions with Large Objects Dialog

Input Data:

Payloads and rocket bodies defined for the mission are included as input for this assessment. The
data displayed in the input grid are “read-only.” To modify the input data, the user must return to
the Define Mission-Related Debris Properties grid of the Mission Editor.

Output Data:

The output area of the dialog displays results listed by component. The output table displays
compliance status of each component, and the computed probability of collision with a large object.
The probability of accidental collision with space objects larger than 10 cm in diameter must be less
than 0.001.

Messages and comments developed during analysis are displayed on the dialog, below the output

data. Note that increased fidelity of the debris environment model results in greatly-increased
DAS run times.
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3.6 Requirement 4.5-2: Probability of Damage from Small Debris

Requirement 4.5-2 limits the probability that a spacecraft will become disabled and unable to
perform end-of-mission tasks, such as disposal maneuvers and passivation. This could contribute to
the long-term growth of the orbital debris environment by subsequent collision or explosion
fragmentation. The probability of a disabling collision with small debris and meteoroids must be
less than 0.01.

Due to the very short mission duration of launch vehicle orbital stages (normally less than
24 hours), the probability of a disabling small debris impact on orbital stages is not significant.

Requirement 4.5-2 applies only to subsystems that are vital to completing postmission disposal.
This would include the propulsion system and all necessary subsystems if a postmission disposal
maneuver is required. If no disposal maneuver is required, only subsystems accomplishing
passivation of the vehicle should be addressed. Examples of such subsystems are batteries and
communications equipment. However, the same methodology can be used to evaluate the
vulnerability of the spacecraft instruments and mission-related hardware. This information can be
used to verify the reliability of the mission with respect to orbital debris and meteoroid hazards.

Payloads are defined in the Mission Editor and displayed in Requirement 4.5-2.
The debris environment model in DAS 2.1 has been simplified by excluding small debris in years

2036-2070. Therefore, DAS 2.1 cannot assess Requirement 4.5-2 for missions operating after
2035. See Appendix C.3 for more information.
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— [Requirement 4.5-2] Probability of Damage from Small Debris

— Pavload Critical Surfaces
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 Indigo €8
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i Balloon

Add Delete
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Quter Wall
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Row [ Mame
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alass Window

3

2

Eun Requirements Help
— Output
Spacecraft Compliance Probability of Critical Probability of
Skatus PMD Failure Surface Penetration
Indigo 67 Mon-Cormpliant 0,302330 zas Tank, 0.018325
Skar Tracker 0.289307
Marcelas 3 Compliant 0.000000 Balloon 0.000000

— Meszages

Indigo 67 Failed

Requirement 4.5-2: Mon-Compliant

MOTE: Far Mon-Compliant Statuz - Refer to Help ar Analysis gection within Science and Engineering Utilities

Figure 3 - 5: Requirement 4.5-2 Probability of Damage from Small Debris Dialog
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Input Data:

Payloads cannot be added to a mission through Requirement 4.5-2, only through the Mission Editor.
Critical surfaces are created and defined for the payload by depressing the “Add” button. Once the
surface has been created, fields to define the critical surface become available.

The user selects a Payload Orientation from the drop-down combo box. Orientation is defined as
one of:

e Random tumbling — No axes will be fixed during the mission lifetime in question.

e Gravity gradient — The gravity (nadir) direction will be maintained with respect to the
spacecraft during the orbital lifetime in question.

e Fixed orientation — The velocity (ram) direction and gravity (nadir) direction will be
maintained with respect to the spacecraft during the orbital lifetime in question.

“Random tumbling” should be used to describe payloads that do not have attitude maintenance
capability. For payloads that are “gravity gradient” or have “fixed orientation,” users must define
unit vectors in spacecraft coordinates.

A critical surface is the surface that, if damaged, may cause postmission disposal to fail. Each
payload may have one or many critical surfaces. Examples of components with critical surfaces
include fuel tanks, conduits, wires, and circuit boards. Each critical surface is defined by surface
name, areal density, surface area, unit normal vectors U, V, W (if Payload Orientation is not random
tumbling), and whether the back wall is the wall of a pressurized vessel (check the box if “Yes”).
The coordinate system is defined as:

e U —“Up” (the direction opposite to the direction of gravity)
e V —In the direction of velocity
e W —“Port” or orthogonal to both U and V (i.e. UxV)

Note that a single hardware component may have more than one critical surface. The user cannot
always tell whether a heavily or weakly armored surface is most vulnerable, since this depends on
the surface’s location on the vehicle. Therefore, assessment needs to account for all “critical
surfaces” of each critical hardware component, including any surface that points in a different
direction or has a different outer wall configuration. Random tumbling surfaces do not need to
consider pointing, but do need to consider wall configurations.

If checked, the check box labeled “Pressurized” indicates that the back wall is the wall of a
pressurized vessel.

Each critical surface requires definition (physical characteristics) of the layers between that surface
and the space environment. These bordering layers include any layers between the back wall and an
external wall, inclusively. The physical characteristics of these layers are defined in the Outer
Walls input grid. Defining characteristics are listed in Table 3-1.
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Table 3 - 1: Requirement 4.5-2 Outer Walls Input Grid

Name A descriptive name (text field) for the layer.

Areal Density Areal Density (gm/cm?) of the layer. The density must be a
positive numeric value greater than zero. Decimal values are
valid. This value accounts for material density and thickness.
Separation Distance | Distance (cm) between the critical surface (i.e. back wall) and
this layer. The distance must be a positive numeric value
greater than zero. Decimal values are valid. The layers do not
need to be sorted by separation distance.

Output Data:

Compliance status for each spacecraft is displayed in the Output and Message area of the dialog as
well as probability that small debris impacts will cause components critical to postmission disposal
to fail. For each spacecraft, each user-defined critical surface is also listed, along with the
probability that the critical surface will be penetrated by a small object.

Messages and comments developed during analysis are displayed on the dialog, below the output
data. Note that increased fidelity of the debris environment model results in greatly-increased
DAS run times.

The assessment of Requirement 4.5-2 should be used to determine whether damaging impacts by
small particles can reasonably prevent successful postmission disposal operations. The procedure
estimates the probability that meteoroid or orbital debris impacts will cause components critical to
postmission disposal to fail. If this estimate shows that there is a significant probability of failure, a
full penetration analysis should be conducted to guide any redesign and to validate any shielding
design.

Note: This module is computationally intensive and may require several minutes to complete. For
each year of the mission (duration), DAS computes penetration probability over a full range of
particle speeds and impact angles.

3.7 Requirement 4.6-1, -2, -3: Postmission Disposal of Space Structures

NASA space programs and projects shall plan for the disposal of spacecraft and launch vehicle
orbital stages and space structures at the end of their respective missions. Postmission disposal
shall be used to remove a space structure from Earth orbit in a timely manner or to leave a space
structure in a disposal orbit where the structure will pose as small a threat as practical to other space
systems.
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The postmission disposal options are (1) natural or directed reentry into the atmosphere within a
specified time frame, (2) maneuver to one of a set of disposal regions in which the space structures
will pose little threat to future space operations, and (3) retrieval and return to Earth. The last
option requires use of the Space Shuttle or similar vehicle and will generally not be an option, due
to logistical constraints, cost, and crew safety.

Requirement 4.6 is divided into the following four postmission disposal categories:

4.6-1 — Disposal for space structures passing through LEO: A spacecraft or orbital stage
with a perigee altitude below 2000 km.

4.6-2 — Disposal for space structures near GEO: A spacecraft or orbital stage in an orbit
near GEO.

4.6-3 — Disposal for space structures between LEO and GEO: A spacecraft or orbital stage
with a perigee altitude between 2000 km and GEO, and which does not qualify as “near
GEO.”

4.6-4 — Reliability of Postmission Disposal Operations in Earth orbit is not addressed by
DAS 2.

4.6-5 — Operational design for EOM passivation is not addressed by DAS 2.

Upon selection of Requirement 4.6, all payloads and rocket bodies defined in the Mission Editor are
categorized (by region), assessed, and displayed in a corresponding grid. Note that for disposal
considerations, “structures near GEO” includes all objects that could potentially penetrate the region
within 500 km (both above and below) of GEO after end-of-mission plus 25 years.
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— [Requirement 4.6-1... 4.6-3] Postmission Dispozal of Space Stucture

— Requiremant 4.6-1

Space Structure | Space Structure | Compliance Suggested Perigee | Suggested Apogee | Perigee Apogee Inclination | Final Area-To-Mass | PMD Perigee PMD Apc
Mamne Twpe Status Alkitude Clm) Alkitude Clm) Altitude fkm) | Albitude (km) | (deg) Ratio (m™2fkg) Alkitude (k) Alkitude 1
Payload 1 Payload Comnpliant 774 781 86,4 0.700 11 33
Payload 2 Payload Comnpliant 774 781 86,4 0.800 736 748
Rocket Body 1 Raocket Body Campliant 1101 1200 36.4 44,000 i} i}

< 1

— Requirement 4.6-2

Space Skruckure Space Skruckure Compliance Suggested Perigee | Suggested Apogee | Perigee Apoges Inclination | RA&AN Argument of | Mean
Iame Twpe Status Altitude (k) Altitude (km) Altitude (km) | Altitude (km) | (deqg) (deq) Perigee (deq) | Anomaly {deg)
Rocket Body 2 Mon-Compliant | 36209 F68TE 35700 35750 5.0 . 3.0 4.0

< 1il

—Requirement 4.6-3
Space Structure | Space Structure | Compliance Suggested Perigee | Suggested Apogee | Perigee Apogee Inclination | FLAAn Argument of | Mean Fine
Iame Type Status Altitude (k) Altitude (k) Altitude (km) | Altitude (km) | {deg) {deqg) Perigee (deq) | Anomaly (deg) Rati
Pavload 3 Pavload Compliant 3347 3542 91.1 2.0 1.1 7.5 0.9(

< 1l
Requirement Help Start Y'ear |1 998.9
—Message:

Requirement 4.6-2
Rocket Body 2
Mon-Compliant

Fail: GED storage PMD.

MOTE: For Mon-Compliant Status - Refer to Help or Analysis section within S cience and Engineenng Utilities

Figure 3 - 6: Requirements 4.6-1, -2, -3: Postmission Disposal of Space Structures Dialog
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Input Data:

Launching Requirement 4.6 will categorize all payloads and rocket bodies defined in the Mission
Editor by requirement region, then run the assessment. The structures are then displayed in a
corresponding grid.

e Requirement 4.6-1 — Disposal for space structures passing through LEO.

e Requirement 4.6-2 — Disposal for space structures near GEO.
[ (GEO-500 km) < Alt. < (GEO+200 km)].

e Requirement 4.6-3 — Disposal for space structures between LEO and GEO.
(2000 km < Alt. < GEO-500 km)).

The input data displayed in the grid are “read-only.” To modify the input data, the user must return
to the Mission Editor’s Define Payload Properties or Define Rocket Body Properties grid.

Output Data:

This dialog analyzes each payload or rocket body defined for the mission and assesses its disposal
compliance based on its orbital definition.

Compliance status is returned for each payload and rocket body. If a space structure is non-
compliant a Suggested Perigee and Apogee Altitude (km) are given. All other entries are input
fields from the Mission Editor.

The fields labeled PMD Perigee Altitude and PMD Apogee Altitude are computed for objects
without a specified PMD maneuver. This is the case for rocket bodies and payloads that are
abandoned at their end-of-mission. If an object is abandoned at the end of its mission, then its PMD
altitudes are set to its end-of-mission altitudes. For station-kept objects these are the same as the
operational altitudes. For non-station-kept and abandoned objects the end-of-mission orbit is found
by propagation. This is the reason the two fields PMD Perigee Altitude and PMD Apogee
Altitude may have different values than those input by the user.

Messages and comments developed during analysis are displayed on the dialog, below the output

data. Non-compliant items are listed by requirement in the message area of the dialog along with a
reason for non-compliance. If any items are non-compliant, Requirement 4.6 fails assessment.
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3.8 Requirement 4.6-4: Postmission Disposal Reliability

DAS 2 cannot assess compliance with Requirement 4.6-4. The project must demonstrate
compliance with Requirement 4.6-4 though its own calculations. For Requirement 4.6-4, contact
the JSC Orbital Debris Program Office for assistance.

3.9 Requirement 4.7-1: Casualty Risk from Uncontrolled Reentry

NASA space programs and projects that use atmospheric reentry as a means of disposal for space
structures need to limit the amount of debris that can survive reentry and pose a threat to people on
the surface of the Earth. This area applies to full spacecraft as well as jettisoned components. This
section of DAS 2 assesses compliance with Requirement 4.7-1.a, which addresses risk from
uncontrolled reentry. DAS 2 does not address concerns related to controlled reentry (Requirement
4.7-1.b).

The risk of human casualty is determined for objects returning to Earth’s surface with a kinetic
energy exceeding 15 Joules. The expected debris casualty area is based on the quantity of each
surviving object multiplied by its casualty area. The casualty risk is the product of the total
expected debris casualty area and the statistical population density based on the orbital inclination
and the year of return. World population densities have been computed up to the year 2070. The
risk from any potential return beyond that year will need to be computed outside DAS 2. For
reference, see “Improvements to NASA’s Estimation of Ground Casualties from Reentering Space
Objects” by J.N. Opiela and M.J. Matney, Space Debris and Space Traffic Management
Symposium, AAS Science and Technology Series, vol. 109, 2004.

In order to calculate the risk of human casualty, the arrangement of each space structure element
needs to be defined to assess its reentry survival potential. Based on empirical and theoretical
values, the outermost structure (i.e. the “parent” object) is assumed to break apart at an altitude of
78 km. The first level of “child” objects is exposed at this point. The objects are then subjected to
the various forces of the reentry model. If a child object is destroyed (“demises”) due to the reentry
forces, it does not affect the final casualty area calculation. If a child object contains further levels
of children, those children are exposed at the same point at which their immediate parent object
demises. This process allows a realistic progression of the exposure of nested structures.

Note that the DAS reentry model includes neither pre-heating of internal structures nor partial
ablation. The lack of pre-heating means that each level of children is exposed with the same
starting temperature of 300 Kelvin. The lack of partial ablation means that an exposed structure’s
cross sectional area is either zero (demised) or is the usual product of the initial dimensions.

Any object with a risk of human casualty above 1:10,000 will be identified as non-compliant.
This part of DAS is intended to be a “first cut” assessment tool, providing somewhat conservative
results. That is, DAS will classify as non-compliant all missions which clearly do not satisfy this

requirement of NASA-STD-8719.14A, but may also classify as non-compliant some missions
which are borderline compliant. For this reason, missions which fail the DAS ODA may require a
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more thorough, higher-fidelity analysis than DAS can provide

the mission design and ODA review processes.

[Requirement 4.7-1] Limit the Risk of Human Casualty
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Figure 3 - 7: Requirement 4.7-1 Limit the Risk of Human Casualty Dialog
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Input Data:

The sub-components and their relationships within each element are defined in a “reentry objects
tree.”

Obijects subject to reentry are provided as root objects, based on a project’s rocket body, payload,
and mission debris data entered in the Mission Editor. All subcomponents of these objects should
be defined (up to four levels deep) for assessment of potential risk of human casualty.

When a mission object is selected, comments are displayed for that object within the Input
Comments field (next to the objects tree). The inclination angle defined within the Mission Editor
is displayed in the Input Comments. A warning is displayed if the mass of defined sub-components
does not define at least 95% of the object’s mass. These comments do not display when sub-
component objects are selected.

When any component is selected, a warning will be displayed if the defined quantity is not a
multiple of the quantity of its immediate “parent” object. Also listed will be any sub-components of

the selected object that do not have quantities defined which are multiples of the object’s quantity.

Each component is defined using the quantities shown in Table 3-2.

Table 3 - 2: Requirement 4.7-1 Sub-component Input Grid

Name Unique textual name for the component.
Qty Integer quantity.
Material Textual material type. A drop-down alphabetic list of defined

materials in the Material Database (DB) (including “user”
materials) for this project. The materials can be selected from
the list or typed in. If the typed material is not found in the
Material DB, the edit will not be accepted. (See Sect. 2.5 for
Material DB.)

Body Type Shape of the element. A drop-down list of acceptable shapes:
Sphere, Cylinder, Flat Plate, Box. Any other typed word will
not be accepted. Body Type must be defined before the
subsequent inputs (which may vary based on Body Type).

Thermal Mass Mass of each element in kilograms. Thermal mass does not
include the mass of defined sub-components.

Diameter/Width The diameter of sphere and cylinder objects, or width of flat
plate and box objects, in meters. Must be greater than or equal
to Height.

Length The length of cylinder, flat plate and box objects, in meters.
Must be greater than or equal to Diameter or Width.

Height The height of box objects, in meters.
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The dimension data are editable based on the body type selected for each element.

Up to four levels of sub-components can be defined using the “Add Sub-ltem” button. A new
element will be added as a sub-component to the currently selected item with a unique label based
on New Component. A row is added below the current item in the Component Data grid for the
new item. The name can be edited within the component data grid. Entering a new name that is
used on another object within the grid will fail and the name will remain unchanged until a unique
name is entered.

As items within the reentry objects tree are selected, the corresponding row in the grid is selected
for data entry. When sub-components at the lowest level are selected, the “Add Sub-Item” button is
disabled to limit further levels.

Note: The mission elements’ data, defined within the Mission Editor, are not available for update
within this dialog.

The structure of a mission element can be defined by adding each sub-component and its sub-items
individually. The data can also be imported from a comma-separated file created in the same format
as the project’s reentry file by selecting the Import Sub-Items button. The data must contain the
quantities listed in Table 3-3. The first row of the file is assumed to contain column headers.

Table 3 - 3: Requirement 4.7-1 Comma-Separated Sub-Component File Format

ID Integer row number, beginning with 1.

Name Unique textual name for the component

Parent Row number for this item’s parent component. The root
element must be defined on row 1 with a parent of 0.

Qty Integer quantity.

Material Textual material type — this is validated against the Material DB

defined for this project. If the given material is not defined in
this project, the material will be left blank and require selection
within the dialog.

Body Type Shape of the element. Valid body types are: Sphere, Cylinder,
Flat Plate, Box.

Thermal Mass Mass of the element in kilograms, not including defined sub-
components.

Diameter/Width The diameter of sphere and cylinder objects, or width of flat
plate and box objects, in meters. Must be greater than or equal
to Height.

Length The length of cylinder, flat plate and box objects, in meters.
Must be greater than or equal to Diameter or Width.

Height The height of box objects, in meters.

38



Microsoft’s Excel spreadsheet can load and save comma-separated values in a text file, which it
gives the extension “.csv”. In Excel, to save a single “worksheet” as a .csv file, select “Save As”
from the File Menu. In the Save As file selection dialog, click on the pull-down selection menu
labeled “Save as type,” and scroll down to the option “CSV (Comma delimited)(*.csv) .” Give the
file a name and click on the “Save” button. Note that Excel does not add trailing commas to delimit
blank cells, so short rows may need to be manually edited (using a text editor) to add the commas
delimiting trailing blank cells. The user will find it instructive to first view and edit the file
(“reentry.csv”’) created by DAS.

Selecting the “Import Sub-Items” button will display the Open File dialog. Select the input file
from its current directory location and select “OK.” The data will be read from the selected file and
added to the reentry objects tree and the Component Data grid. Imported data will be saved in the
project\reentry.csv file. Names that are not unique will be empty within the grid and must be
renamed before the data can be assessed. Editing the name within the grid will change the name
within the tree.

A selected sub-component and its defined elements can be deleted with the “Delete Item” button.
The user will be prompted to confirm that the item and its contents are to be deleted. The delete
button is disabled when a mission element is selected.

All required data defined in the component grid are validated when the “Run” button is selected.
Data validity is based on the following:
e All required fields have been entered for each object.

e For components with multiple dimensions, the values must be entered such that Length >
Width > Height.

e Defined mass does not exceed a limit determined by the material density and the object’s
dimensions.

Note: The computed density for a flat plate is based on a height of one-tenth the width. A
thicker plate, or one which does not pass input validation, should be modeled as a box.

e A cylinder must have a length of at least 30% of its diameter. If its length is less than 10%
of its diameter, then define the component as a flat, square plate of equivalent area. If its
length is between the 10% and 30% limits, then the component may be approximated as a
box with equivalent area.

If any of the data are not valid, the assessment ceases and the dialog selects the invalid object. The
data must be corrected before the process can continue.

Output Data:

Output data will provide information (see Table 3-4) on compliance of each mission element.
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Table 3 - 4: Requirement 4.7-1 Mission Element Output Data

Object Name The name defined within the Mission Editor for
objects determined to qualify for reentry analysis.
Compliance Status The result of analysis: Compliant or Non-Compliant.
Non-Compliant data will be highlighted in red text.
Risk of Human Casualty The computed results are displayed in 1:nnn format.
Any risk larger than 1:10,000 will result in non-
compliance.

Total Debris Casualty Area The sum of debris casualty area for all sub-
components possessing Kinetic energy greater than
15 Joules.

The displayed data for sub-components and mission elements without subcomponents is shown in
Table 3-5.

Table 3 - 5: Requirement 4.7-1 Sub-Component Output Data

Sub-Component Object The name provided for the subcomponent object.

Demise Altitude Predicted demise altitude in kilometers. Altitude of
zero (0) indicates surviving debris expected to impact
Earth.

Total Debris Casualty Area Predicted casualty area of debris in square meters.

Objects demising above Earth’s surface will have a
debris casualty area of zero (0).

Kinetic Energy The impacting kinetic energy in Joules. Any item
with kinetic energy above 15 Joules will be displayed
in red.

Messages and comments developed during analysis are displayed on the dialog, below the output
data. The user should press the “Reset” button in the top-level Requirement Assessments dialog
window before editing the inputs for this Requirement for the purpose of making additional
assessment runs.

When the project is saved, all input and output data for this dialog are saved in the
project\reentry.csv file.

3.10 Requirement 4.8-1: Mitigate the Collision Hazard of Space Tethers

NASA space programs and projects shall assess and limit the collision hazard posed by tether
systems on other users of space and on the near-Earth environment. This requirement applies to all
space structures using tethers in Earth or lunar orbits.

DAS provides a means to define a basic tether system for assessment. Because of the wide range of

design parameters which have a great effect on assessing a tether, several simplifying assumptions
must be made by DAS:
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If a tether system cannot be defined within these limits, contact the JSC Orbital Debris Program

The tether system is gravity-gradient stabilized and under tension.
The tether is a simple, single strand.
The tether is used only for the purpose of deorbit.
The tether is not retracted once deployed.
Only LEO orbits are allowed (i.e., apogee height is not greater than 2000 km).

Only near-circular orbits are allowed (i.e., the difference between apogee and perigee

heights is not greater than 50 km).
The mean anomaly or the orbit is not necessary because the apogee is in LEO.

Office for further assessment qualifications.

— [Requirement 4.8-1] Collizion Hazards of Space Tethers

— Input
End Objects:
Mame fass | Cross-Sectional | Perigee  |Apogee  |[Inclination | RAAN | Argument of
Py kaq) Area (m™ 2 Alt (k) [ Al (k) | (deg) (deqg) Perigee (deq)
1 Tether Experiment & 1,25 01 305 314 26,5
2 Tether Experirnent B 500 0.5
|=—
Tether
Diameter Lerngth hass ErA Tether ErA Duration Deployrnent Year
Pz | {rm) {m) kay (check if yes) days) NN
1 ni 40.5 .05 |_ 2005.5

Bun Requirement Help |
— Output
Tether Requirerment 4.5-1 | Requirernent 4,5-2 | Requirerment 4.6 Orbital Decay
Ran | State Compliance Status | Compliance Status | Compliance Status | (days)
1 rrarnenturn Cornpliant Caornpliant Carnpliant 2.0

— Mezzages

Requirerment 4.8-1: Compliant

Figure 3 - 8: Requirement 4.8-1 Collision Hazards of Space Tethers Dialog
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Input Data:

A basic tether system is made up of two end objects connected by a momentum tether or an
electromagnetic (EM) tether. EM tethers are assumed to be used for deorbit only. If an EM tether
IS to be used for purposes other than deorbit (e.g. orbit maintenance), then it must be assessed
outside of DAS.

The End Objects (“End Masses™) grid is provided to define the orbit and mass of each object. End
objects used for tether system definition can be selected from previously defined mission objects
(rocket body, payload or mission debris). However, this requirement also supports end objects
defined for this purpose alone. The required data are the orbit, mass, and area of the higher-altitude
object and the mass and area of the lower-altitude object.

Table 3-6 summarizes the required input data for the tether end objects.

Table 3 - 6: Requirement 4.8-1 End-Object Input Data

Name Textual name for the component. To edit this data, a drop
down list includes previously defined objects either from the
mission editor or objects defined within this dialog. Selecting
an object from the mission will load previously defined data.
Entering a name that has not been defined will blank all
columns of data for that object.

Mass Mass of the end object (kg).

Cross-Sectional Area | Cross-sectional area of the end object (m?).

Perigee Perigee altitude for the object during deployed phase (km).

Apogee Apogee altitude for the object during deployed phase (km).

Inclination Inclination of the object’s orbit in degrees.

RAAN (Optional) Right Ascension of ascending node (RAAN):
0-360 degrees.

ArgP (Optional) Argument of perigee: 0-360 degrees.

Assessment uses the object mass and area data for both objects and the orbital data for the higher
altitude object. These data cells are editable in case the tether deployment data differ from the
underlying mission object.

The Tether grid is used to define the tether. The required data are the tether’s diameter, length,

mass, type (EM or momentum), and mission duration if the tether is EM. Optional data include
deployment date and retraction date.
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Table 3-7 summarizes the required input data for the tether.

Table 3 - 7: Requirement 4.8-1 Tether Input Data

Diameter The tether’s diameter in meters.

Length The tether’s length in meters.

Mass The tether’s mass in kg.

EM Tether Check box to select the type of tether: Check “yes” for an EM
tether or leave blank (“no”) for a momentum tether.

EM Duration Number of days that the EM tether is actively deployed. This cell
is disabled for momentum tethers.

Deployment Year (Optional) The date that the tether is deployed. The format is
YYYY for year and .YY for fraction of year.

All data must be defined before the “Run” button is pressed. All required data are verified before

assessment. If data are not provided, the assessment will prompt the user to complete data entry.

Output Data:

The output grid will provide information on compliance of the system for the following cases:

e Requirement 4.5-1 — The probability of collision with space objects larger than 10 cm is

e Requirement 4.5-2 — The probability of disabling collision with small objects is less than

e Requirement 4.6 —

The assessment output data (see Table 3-8) are provided in the Output grid. Note that increased

less than 0.001.

0.01.

Natural decay will occur within the minimum of 25 years after
mission or 30 years after launch.

fidelity of the debris environment model results in greatly-increased DAS run times.
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Table 3 - 8: Requirement 4.8-1 Output Data

Tether State The assessed state. EM tethers are analyzed as a
successful EM and as a failed EM, equivalent to a
momentum tether.

Requirement 4.5-1 Compliance | The result of assessment. Compliant or Non-
Compliant. Non-Compliant data will be highlighted in
red text.

Requirement 4.5-2 Compliance | The result of assessment. Compliant or Non-
Compliant. Non-Compliant data will be highlighted in
red text.

Requirement 4.6-1 Compliance | The result of assessment. Compliant or Non-
Compliant. Non-Compliant data will be highlighted in
red text.

Orbital Decay The computed result is displayed as the predicted
number of days for orbital decay. Any orbital lifetime
longer than the minimum of 30 years and 25 years
beyond mission will result in non-compliance.

In the case of Requirement 4.5-1 or 4.5-2 non-compliance, analysis of severed tether is provided for
each end object. Half the mass of the tether is added to each end object when assessing compliance
with Requirement 4.6.

In the case of EM tethers, the system is assessed for successful electro-magnetic function as well as
compliance in the case of failure and the tether functioning as momentum only.

In all cases, the tether system is assessed for possible severance. If severance is determined as
likely, each end mass is assessed for compliance with Requirement 4.6 based on its own mass and
the mass of half the tether.

Note: If the mass of an end object exceeds 500 kg that object should be defined within the Mission
Editor for Requirement 4.7-1 assessment.

Messages and comments developed during analysis are displayed on the dialog, below the output
data.

All input data for this dialog are saved in the tetherObjects.csv and tether.csv files within the project
directory.
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4. Science and Engineering Utilities

The Science and Engineering Utilities are intended to answer questions of general interest for debris
assessments that might or might not also be covered in the specific requirement areas. In the left
window pane of the GUI, preceding each section of the Science and Engineering Utilities tree, is an
image. Utilities with a flask image ¥ allow calculations. Descriptive levels of the tree are denoted
by a page O image. Expand the folder levels by depressing the adjacent plus #-, revealing the
calculating utilities.

4.1 On-Orbit Collisions

These Science and Engineering Utilities may assist users in the assessment of compliance with
Requirement 4.5, to limit the probability of operating space systems becoming a source of debris
through collisions with orbital debris or meteoroids.

Three contour plotting tools are available within this category. They include Debris Impacts vs.
Orbit Altitude, Debris Impacts vs. Debris Diameter, and Debris Impacts vs. Date. Each
contour plot can be displayed in terms of Impact Rate or Number of Impacts.

IMPORTANT NOTE: The utilities in this section repeatedly perform calculations using ORDEM-
based routines over a range of times and orbits. Because each calculation using the higher-
fidelity ORDEM 3.0 takes much longer than in previous versions of DAS, the On-Orbit
Collisions utilities may require overnight run times. See Appendix C.3 for more information.

4.1.1 Debris Impacts vs. Orbit Altitude

This utility plots the expected impacts along contours of impactor diameter, in centimeters, as a
function of orbit altitude, in kilometers (assuming a circular orbit). The plot indicates the number
(or number per year) of impacts, of each impactor size and larger, that the user may expect upon a
spacecraft. The user may select either “Impact Rate” or “Number of Impacts” for the vertical axis.
“Orbital Altitude” is on the horizontal axis. Both Impact Rate and Number of Impacts are given on
a logarithmic (base 10) scale. The results are cumulative down to each user-specified diameter
threshold value. Figure 4-1 shows the input dialog, and Table 4-1 defines the values.
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This utility is useful for visualizing both quantitative and qualitative characteristics of the debris
environment at different altitudes.

Debris Impacts vz, Orbit Altitude

[t

Start rear |2EIEIE {0
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Avg, 5/C ¥-Sectional Area |'||:| "2
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Type af Environment |Metenruid3 % Orhital Debrisﬂ
Impactor Diameter 'ID--I i
100
Plat Type

" Impact B ate ws Orbital Altitude
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cm

Remaove

Flat Fleset Help

Figure 4 - 1: Debris Impacts vs. Orbit Altitude Input Dialog
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Table 4 - 1: Debris Impacts vs. Orbit Altitude Input Data

Start Year The beginning date (in decimal years) for the time period
currently under study. The input value must be a positive
numeric value equal to or greater than 2010 and less than
or equal to 2070. In addition, the sum of the Start Year
and the Duration must not exceed the year 2070.
Duration The length of time (decimal years) currently under study.
This input value must be a positive numeric value greater
than zero. In addition, the sum of Duration and Start
Year must not exceed 2070.

Avg S/C X-Sectional Area The average projected cross-sectional area (in square
meters) of the spacecraft. A positive, numeric value is

required.

Inclination The orbital inclination angle. Positive, numeric degrees
between zero and 180 (inclusive). Decimal numbers are
accepted.

Type of Environment Select one: Meteoroids & Orbital Debris; Orbital Debris
Only; or Meteoroids Only.

Impactor Diameter Define the lower threshold for each plot contour. All

Threshold diameters above the given threshold will be included.

Enter the diameter (in centimeters) in the edit box below
the list, then press “Add” to include the value in the list.
Select a previously defined threshold and press
“Remove” to delete it from the list. The maximum
number of entries is 20. Each entry must be a positive
numeric value and decimal values are acceptable.

Plot Type The vertical plot axis, either Impact Rate or Number of
Impacts. Either choice displays the logarithmic (base 10)
values along the vertical axis against the Orbital Altitude
(in kilometers) along the horizontal axis, assuming a
circular orbit.

The “Reset” button will clear all input values from the dialog.

Depressing the “Plot” button sends input values from the dialog to the calculating routines. As the
utility processes the data, a Processing dialog will appear. The processing may take several
minutes to complete. To cease processing, depress the “Stop” button on the dialog.

If no points are calculated, a message box will appear notifying the user. The user must then select
“OK” to exit the message box.

Output Data:

The generated plot is viewable in a separate plot window. Using the log10 scale, the actual values
are 10 raised to the power of the plotted value (val=10P"°"2). Section 2.6, Using the Plot Viewer,
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provides information on plot utility functions. The underlying data are automatically saved as file
plots/ImpactGivenAlt.dpl.

Y "
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-3
-35
4.0
45
-5.00

-5.48 »
2000 G000 1000.0 1400.0 1800.0 Altitude
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Plot 1 - Debris Impacts vs. Orbit Altitude

4.1.2 Debris Impacts vs. Debris Diameter

This utility plots the expected impacts along contours of orbital altitude as a function of debris
diameter (assuming a circular orbit). The plot indicates the number (or number per year) of
impacts, for each selected altitude, that the user may expect upon a spacecraft. The user may select
either “Impact Rate” or “Number of Impacts” for the vertical axis. “Debris Diameter” is on the
horizontal axis. Impact Rate, Number of Impacts, and Debris Diameter are given on a logarithmic
(base 10) scale. The results are cumulative down to the diameter threshold value. Figure 4-2 shows
the input dialog, and Table 4-2 defines the values.
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This utility is useful for visualizing both quantitative and qualitative characteristics of the debris
environment at different minimum debris sizes.

Debriz Impacts vz, Debriz Diameter
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Figure 4 - 2: Debris Impacts vs. Debris Diameter Input Dialog
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Table 4 - 2: Debris Impacts vs. Debris Diameter Input Data

Start Year The beginning date (in decimal years) for the time period
currently under study. The input value must be a positive
numeric value equal to or greater than 2010 and less than
or equal to 2070. In addition, the sum of the Start Year
and the Duration must not exceed the year 2070.
Duration The length of time (decimal years) currently under study.
This must be a positive numeric value greater than zero.
The sum of Duration and Start Year must not exceed
2070.

Avg S/C X-Sectional Area The average, projected cross-sectional area (in square
meters) of the spacecraft. A positive, numeric value is

required.

Inclination The orbital inclination angle. Positive, numeric degrees
between zero and 180 (inclusive). Decimal numbers are
accepted.

Type of Environment Select one: Meteoroids & Orbital Debris; Orbital Debris
Only; or Meteoroids Only.

Orbital Altitude Define the orbital altitude for each plot contour. Enter

the altitude (km) in the edit box below the list, then press
“Add” to include the value in the list. Select a previously
defined altitude and press “Remove” to delete it from the
list. The maximum number of entries is 20. Each entry
must be a positive numeric value, and decimal values are
acceptable.

Plot Type The vertical plot axis, either Impact Rate or Number of
Impacts. Either choice displays the logarithmic (base 10)
values along the vertical axis against the Debris Diameter
[in logio(cm)] along the horizontal axis, assuming a
circular orbit.

The “Reset” button will clear all input values from the dialog.

Depressing the “Plot” button sends input values from the dialog to the calculating routines. As the
utility processes the data, a Processing dialog will appear. To cease processing, depress the “Stop”
button on the dialog.

If no points are calculated, a message box will appear notifying the user. The user must then select
“OK?” to exit the message box.
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Output Data:

The generated plot is viewable in a separate plot window. Using the log10 scale, the actual values
are 10 raised to the power of the plotted value (val=10P"°"?). Section 2.6, Using the Plot Viewer,
provides information on plot utility functions. The underlying data are automatically saved as file
plots/ ImpactGivenDia.dpl.
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Plot 2 - Debris Impacts vs. Debris Diameter

4.1.3 Debris Impacts vs. Start Date

This utility plots the expected impacts along contours of impactor diameters, in centimeters, as a
function of starting date, in years (assuming a circular orbit). The plot indicates the number (or
number per year) of impacts, for each impactor size and larger, that the user may expect upon a
spacecraft. Results are a function of start (i.e. launch) date. The user may select either “Impact
Rate” or “Number of Impacts” for the vertical axis. “Start Date” is on the horizontal axis. Both
Impact Rate and Number of Impacts are given on a logarithmic (base 10) scale. The results are
cumulative down to each user-specified diameter threshold value. Figure 4-3 shows the input
dialog, and Table 4-3 describes the values.
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This utility is useful for visualizing both quantitative and qualitative characteristics of the debris
environment for different launch years.
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Figure 4 - 3: Debris Impacts vs. Date Dialog
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Table 4 - 3:

Debris Impacts vs. Start Date Input Data

Duration

The length of time (decimal years) currently under study.
This must be a positive numeric value greater than zero.
In addition, the sum of Start Year and Duration must not
exceed the year 2070.

Orbit Altitude

The distance, in kilometers, of the object above Earth’s
surface, assuming a circular orbit.

Avg S/C X-Sectional Area

The average projected cross-sectional area (in square
meters) of a spacecraft. A positive, numeric value is
required.

Inclination

The orbital inclination angle. Positive, numeric degrees
between zero and 180 (inclusive). Decimal numbers are
accepted.

Type of Environment

Select one: Meteoroids & Orbital Debris; Orbital Debris
Only; or Meteoroids Only.

Impactor Diameter
Threshold

Define the lower threshold for each plot contour. All
diameters above the given threshold will be included.
Enter the diameter in centimeters in the edit box below
the list, then press “Add” to include the value in the list.
Select a previously defined threshold and press
“Remove” to delete it from the list. The maximum
number of entries is 20. Each entry must be a positive
numeric value and decimal values are acceptable.

Plot Type

The vertical plot axis, either Impact Rate or Number of
Impacts. Either choice displays the logarithmic (base 10)
values along the vertical axis against the Date (in years)
along the horizontal axis, assuming a circular orbit.

The “Reset” button will clear all input values from the dialog.

Depressing the “Plot” button sends input values from the dialog to the calculating routines. As the
utility processes the data, a Processing dialog will appear. To cease processing, depress the “Stop”

button on the dialog.

If no points are calculated, a message box will appear notifying the user. The user must then select

“OK” to exit the message box.

Output Data:

The generated plot is viewable in a separate plot window. Using the log10 scale, the actual values
are 10 raised to the power of the plotted value (val=10P"°"?). Section 2.6, Using the Plot Viewer,
provides information on plot utility functions. The underlying data are automatically saved as file

plots/ImpactGivenDate.dpl.
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4.2 Analysis of Postmission Disposal Maneuvers

W04 Diameter: 100.00 (cm)
W0z Diameter: 1.00 (om)
W0z Diameter: 0.10 com)

These Science and Engineering Utilities may assist users in the assessment of compliance with
Requirement 4.6, the “postmission disposal of space structures.” These utilities address orbital
maneuvers necessary for disposal by atmospheric reentry or potential storage orbits above LEO.

Two utilities are available within this group. Disposal by Atmospheric Reentry is a plotting
utility that plots disposal Delta-V contours as a function of Initial Perigee and Initial Apogee.
Maneuver to Storage Orbit calculates First Burn, Second Burn, and the Total Delta-V required to
reach the minimum acceptable storage orbit. Reentry Survivability Analysis provides this
function, self-contained and separate from an actual mission assessment.
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4.2.1 Disposal by Atmospheric Reentry

This utility plots contours of Delta-V corresponding to the Delta-V required to move from LEO to a
decay orbit with a user-specified lifetime. This may aid the user in determining the cost of deorbit
maneuvers. Users should specify at least one Delta-V contour value. Figure 4-4 shows the input

dialog, and Table 4-4 describes the values.

Digpozal by Atmozpheric Beenty
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Decay Orhit Lifetime |22
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Pliok Reset Help
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mds

mds

Figure 4 - 4: Disposal by Atmospheric Reentry Input Dialog
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Table 4 - 4: Disposal by Atmospheric Reentry Input Data

Start Year Marks the beginning date (in decimal form) for the time period
currently under study. The input value must be a positive
numeric value equal to or greater than 2010 and less than or
equal to 2070. In addition, the sum of the Start Year and
Decay Orbit Lifetime must not exceed the year 2070.

Decay Orbit Lifetime The length of the orbital lifetime, beginning at the Start Year.
It is required to be in years (decimal years are acceptable).
This input value must be a positive, numeric value greater than
zero. In addition, the sum of the Start Year and Decay Orbit
Lifetime must not exceed the year 2070.

Area-to-Mass The object’s average cross-sectional area (m 2) divided by its

final mass (kg). A positive, numeric value is required, and a
decimal value is acceptable.

Delta-V Each contour value is entered into the edit box below the list.
Once entered, the user depresses the “Add” button to load the
value into the list.

The user may remove a previously defined contour value by
highlighting the value and depressing the “Remove” button.
The maximum number of entries is 20. Each entry must be a
positive, numeric value, and decimal values are acceptable.
Units are m/s.

The “Plot” button will send input values from the dialog to the calculating routines. As the utility
processes the data, a Processing dialog will appear. Plot processing may take several minutes. To
cease processing, depress the “Stop” button on the dialog.

The calculating routines will produce a plot of returned points. If no points are returned, a warning
message will be generated, requiring the user to click the OK button to continue.

The “Reset” button will clear all input values from the dialog.
Output Data:

The generated plot is viewable in a separate plot window. The user can find the disposal Delta-V
requirement for any low-Earth orbit by pairing perigee and apogee values from the plot axes. On
the plot, Delta-V increases from the bottom and left toward the top and right. Note that, by
definition, no values exist above the 1:1 boundary line. Section 2.6, Using the Plot Viewer,
provides information on plot utility functions. The underlying data are automatically saved as file
plots/AtmReentry.dpl.
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4.2.2 Maneuver to Storage Orbit

This utility calculates the minimal storage orbit and the Delta-V required to maneuver from the
object’s initial orbit to that storage orbit using a two-burn, minimum-energy transfer orbit. This
may aid the user in determining the cost of a storage orbit maneuver. Figure 4-5 shows the
input/output dialog, and Tables 4-5 and 4-6 describe the input and output values.
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Table 4 - 5: Maneuver to Storage Orbit Input Data

Perigee Altitude The perigee altitude (in kilometers) for the object currently
under study, immediately before the maneuver to storage orbit.
The input value must be a positive numeric value greater than 90
and less than or equal to 100,000. In addition, the perigee
altitude must be less than or equal to the apogee altitude.

Apogee Altitude The apogee altitude (in kilometers) for the object currently under
study, immediately before the maneuver to storage orbit. The
input value must be a positive numeric value greater than 90 and
less than or equal to 100,000. In addition, the apogee altitude
must be equal to or greater than the perigee altitude.

Area-To-Mass The object’s average cross-sectional area (m 2) divided by its
final mass (kg). The input value must be a positive numeric
value greater than or equal to 0.00001 (mzlkg) and less than or

equal to 1000 (mzlkg).

This value is only required when all or part of the orbit resides in
the range of GEO +/- 200 km.

The “Run” button sends the user input to the calculating routines. If input values are valid, the
output fields will display the calculated results. Messages and comments developed during
calculation are displayed on the dialog, below the output data.

The “Reset” button clears all input values from the dialog.
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Table 4 - 6: Maneuver to Storage Orbit Output Data

Storage Orbit — Perigee
Altitude

The suggested storage orbit perigee required to minimally
satisfy the postmission disposal requirement.

Storage Orbit — Apogee
Altitude

The suggested storage orbit apogee required to minimally
satisfy the postmission disposal requirement.

Transfer Orbit — Perigee
Altitude

The calculated perigee altitude attained after Delta-V (first
burn).

Transfer Orbit — Apogee
Altitude

The calculated apogee altitude attained after Delta-V (first
burn).

First Burn Delta-V

The Delta-V required to place the object on the minimum-
energy transfer orbit connecting the initial and storage orbits.

Second Burn Delta-V

The Delta-V required to move the object from the transfer
orbit to the storage orbit.

Total Delta-V The Delta-V required to maneuver the object from initial to
disposal orbit, using a two-burn, minimal energy transfer.
This quantity represents the sum of the first and second burn
Delta-V’s.

Message The possible returned messages include the following:

e No associated message for object

e Input orbit parameters do not satisfy any storage
categories

¢ Initial perigee is low enough that user should
consider disposal by atmospheric reentry

e Initial orbit is in (non-semisynchronous) medium
Earth orbit; no disposal maneuver is necessary

4.2.3 Reentry Survivability Analysis

This utility provides a tool to study reentry survivability without changing the input characteristics
of the actual mission (as specified in the Mission Editor). A single object and its subcomponents
can be assessed, rendering the demise altitude, total debris casualty area, and kinetic energy for each
item.

Based on empirical and theoretical values, the outermost structure (i.e. the “parent” object) is
assumed to break apart at an altitude of 78 km. The first level of “child” objects are exposed at this
point. The objects are then subjected to the various forces of the reentry model. If a child object is
destroyed (“demises”) due to the reentry forces, it does not affect the final casualty area calculation.
If a child object contains further levels of children, those children are exposed at the same point at
which their immediate parent object demises. This process allows a more realistic progression of
the exposure of nested structures.

This utility supports the definition of a single object and its sub-components. See Table 3-2

(Sect. 3.9) for a description of the input data. Figure 4-6 shows the input dialog, and Table 4-7
describes the output values.
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— Re-Entry Calculation
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Output Data:
The displayed data for the root element and its sub-components’ survivability are shown in

Table 4-7. Note that since the root object is assumed to break up at 78 km, its output will only
contain the sum of its sub-components’ debris casualty area.

Table 4 - 7: Reentry Survivability Output Data

Sub-Component Object The name provided for the subcomponent object.

Demise Altitude Predicted demise altitude in kilometers. An altitude of
zero (0) indicates surviving debris is expected to
impact Earth.

Total Debris Casualty Area Predicted casualty area of debris in square meters.

Objects demising above Earth’s surface will have a
debris casualty area of zero (0).

Kinetic Energy The impacting kinetic energy in Joules. Any item
with Kinetic energy above 15 Joules will be displayed
in red.

4.3 Orbit Evolution Analysis

These Science and Engineering Utilities may assist users in the assessment of compliance with
Requirement 4.6, the “postmission disposal of space structures.”

Two utilities are available within this group. Apogee/Perigee Altitude History for a Given Orbit

is a plotting utility that plots Apogee/Perigee History over time. Orbit Lifetime/Dwell Time
calculates Orbit Lifetime and LEO Dwell Time, and the final year of propagation.
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4.3.1 Apogee/Perigee Altitude History for a Given Orbit

This utility creates a predicted “history” of Perigee and Apogee Altitudes for the user-entered orbit
elements. The output of this utility is a plot of Altitude (in kilometers) along the vertical axis and
Time (in years) along the horizontal axis. For LEO objects, the plot may indicate the orbital decay
rate and reentry date. Figure 4-7 shows the input dialog, and Table 4-8 describes the values.

ApogeesPerigee Alkitude Higtom for a Given Orbit

| ripLat

Perigee Altitude |5|Jn ke

Apogee Alitude |1200 ke

Inclination |'|5.|:| deq
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Argument of Periges |EIEI deg

b ean Anomaly |EI deg
Area-To-Mass Ratio |D.D15 m”™2/kg
Start “fear |2EIEIE.2 [mpest. ]

Integration Time |1EIEI o
Beset Help |

Figure 4 - 7: Apogee/Perigee Altitude History for a Given Orbit Input Dialog
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Table 4 - 8: Apogee/Perigee Altitude History for a Given Orbit Input Data

Perigee Altitude

The perigee altitude (in kilometers) for the object currently
under study. The input value must be a positive numeric
value greater than 90 and less than or equal to 100,000. In
addition, the perigee altitude must be less than or equal to the
apogee altitude.

Apogee Altitude

The apogee altitude (in kilometers) for the object currently
under study. The input value must be a positive numeric
value greater than 90 and less than or equal to 100,000. In
addition, the apogee altitude must be greater than or equal to
the perigee altitude.

Inclination

The orbital inclination angle. Positive, numeric degrees
between zero and 180 (inclusive). Decimal numbers are
accepted.

R.A. of Ascending Node

Right Ascension of Ascending Node must be a positive
numeric value (in degrees) greater than or equal to 0 and less
than or equal to 360. Decimal entries are valid.

Although all input fields are required, entry into this field
will not affect the calculations when the apogee altitude is
less than 2000 km.

Argument of Perigee

A positive numeric value (in degrees) greater than or equal
to 0 and less than or equal to 360. Decimal entries are valid.
Although all input fields are required, entry into this field
will not affect the calculations when the apogee altitude is
less than 2000 km.

Mean Anomaly

Positive numeric value (in degrees) greater than or equal to 0
and less than or equal to 360. Decimal entries are valid.
Although all input fields are required, entry into this field
will not affect the calculations when the apogee altitude is
less than 2000 km.

Area-To-Mass Ratio

The object’s average cross-sectional area (mz) divided by its
final mass (kg). The input value must be a positive numeric

value greater than or equal to 0.00001 (mzlkg) and less than
or equal to 1000 (mzlkg). Decimal entries are valid.

Start Year

The beginning date (in decimal years) for the time period
currently under study. The input value must be a positive
numeric value equal to or greater than 2010 and less than or
equal to 2070. In addition, the sum of the Start Year and the
Integration Time must not exceed the year 2070.

Integration Time

The length of time (decimal years) desired for propagation.
This input value must be a positive numeric value greater
than zero. In addition, the sum of Integration Time and Start
Year must not exceed 2070.
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The “Reset” button will clear all input values from the dialog.

Depressing the “Plot” button sends input values from the dialog to the calculating routines. As the
utility processes the data, a Processing dialog will appear. To cease processing, depress the “Stop”
button on the dialog.

If no points are calculated, a message box will appear notifying the user. The user must then select
“OK” to exit the message box.

Output Data:

The generated plot is viewable in a separate plot window. Section 2.6, Using the Plot Viewer
provides information on plot utility functions. The underlying data are automatically saved as file
plots/AltHistory.dpl.
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9B0.0 Area-To-Mazz = 0.015 m™2kg
a40.0
7200
G000
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2400
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20052 201049 20166 20223 20280 20337 Z039.3Year

Plot 5 - Apogee/Perigee Altitude History for a Given Orbit
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4.3.2 Orbit Lifetime/Dwell Time

This utility calculates the Orbital Lifetime and LEO Dwell Time of an object in a specified orbit.
These values relate directly to the assessment of the Requirements imposed on LEO debris. The
Message area (below the Output area) of the dialog will display a message to users upon process
completion. Figure 4-8 shows the input/output dialog. The input and output values are described in
Tables 4-9 and 4-10, respectively.

Orbit LifetimedThwell Time
| puk

Start Year [ex 2005.4)  |2008.1

Perigee dlttude 1200 ko
Apogee Altitude | 3001 krm
Inclination |96.4 deg
Fi. A of Ascending Node |0 deg
Argument of Perigee |0 deg
brea-to-Mazs |0.00733 m”2/kg
Rezet Help
Cutpuk
Calculated Orbit Lifetime | 2.203 o
Calculated Orbit Dweell Time  |2.656 o
Lazt year of propagation | 2008 o
Meszages

Object reentered.

Figure 4 - 8: Orbit Lifetime/Dwell Time Dialog
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Table 4 - 9: Orbit Lifetime/Dwell Time Input Data

Start Year The beginning date (in decimal years) for the time
period currently under study. The input value must be
positive, numeric, and fall in the range of 2010-2070.

Perigee Altitude The perigee altitude (in kilometers) for the object
currently under study. The input value must be a
positive numeric value greater than 90 and less than or
equal to 100,000. In addition, the perigee altitude
must be less than or equal to the apogee altitude.

Apogee Altitude The apogee altitude (in kilometers) for the object
currently under study. The input value must be a
positive numeric value greater 90 and less than or
equal to 100,000. In addition, the apogee altitude
must be greater than or equal to the perigee altitude.

Inclination The orbital inclination angle. Positive, numeric
degrees between 0 and 180 (inclusive). Decimal
numbers are accepted.

R. A. of Ascending Node Right Ascension of Ascending Node must be a
positive numeric value (in degrees) greater than or
equal to 0 and less than or equal to 360. Decimal
entries are valid. Although all input fields are
required, entry into this field will not affect the
calculations when the apogee altitude is less than
2000 km.

Argument of Perigee A positive numeric value (in degrees) greater than or
equal to 0 and less than or equal to 360. Decimal
entries are valid. Although all input fields are
required, entry into this field will not affect the
calculations when the apogee altitude is less than
2000 km.

Area-to-Mass The object’s average cross-sectional area (mz) divided

by its final mass (kg). The input must be a positive

numeric value greater than or equal to 0.00001 (m2
/kg) and less than or equal to

1000 (mZ/kg). Decimal entries are valid.

The “Reset” button will clear all input from the dialog.
The “Run” button sends the user input to the calculating routines. If input values are valid, the

output fields will display the calculated results. Messages and comments developed during
calculation are displayed on the dialog, below the output data.
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Output Data:

Table 4 - 10: Orbit Lifetime/Dwell Time Output Data

Calculated Orbit Lifetime Orbital Lifetime is calculated from the Start Year.

Calculated Orbit Dwell Time | The time spent in LEO during Orbital Lifetime.

Last Year of Propagation The year that the object either reentered or exceeded the
propagation time limit.

Messages The message area displays a textual message after

completion of “Run.”
The possible returned messages include the following:
e No associated message for object
e Object will remain in orbit and above LEO for
the foreseeable future (>100 years)
o NOTE: The orbit is NOT processed.
e Object reentered
e Object did not reenter within the maximum years
of propagation.

4.4 Delta-V for Postmission Maneuver

These Science and Engineering Utilities may assist users in the assessment of compliance with
Requirement 4.6, the “postmission disposal of space structures.” These utilities calculate the
change in velocity required for maneuvers needed to achieve atmospheric reentry within 25 years.

Two utilities are available within this group. Delta-V for Decay Orbit Given Orbital Lifetime
plots area-to-mass contour points corresponding to the Delta-V required to move an object, with a
specified orbital lifetime, from an initial circular LEO orbit to a decay orbit. The user specifies a
list of area-to-mass contour values. Delta-V for Decay Orbit Given Area-To-Mass plots lifetime
contour points corresponding to the Delta-V required to move an object, with a specified area-to-
mass ratio, from an initial circular LEO orbit to a decay orbit.

4.4.1 Delta-V for Decay Orbit, Given Orbital Lifetime
This utility plots Area-To-Mass ratio contour points corresponding to the Delta-V required to move
an object, with specified Orbital Lifetime, from an initial circular LEO to a decay orbit. The user

specifies a list of Area-To-Mass contour values. The plot allows the user to explore the cost of
deorbiting a vehicle. Figure 4-9 shows the input dialog, and Table 4-11 describes the values.
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Figure 4 - 9: Delta-V for Decay Orbit Given Orbital Lifetime Dialog

Table 4 - 11: Delta-V for Decay Orbit Given Orbital Lifetime Input Data

Start Year

The beginning date (in decimal years) for the time period currently
under study. The input must be a positive numeric value equal to or
greater than 2010 and less than or equal to 2070. In addition, the
sum of the Start Year and the Orbital Lifetime must not exceed the
year 2070.

Orbit Lifetime

The length of time (decimal years) the object is expected to stay in
orbit. This input value must be a positive numeric value greater
than or equal to 0.01 and less than or equal to 10,000.0; however,
the sum of Orbital Lifetime and Start Year must not exceed 2070.

Area-To-Mass

Each Area-To-Mass ratio contour value is entered into the edit box
below the list. Once entered, the user depresses the “Add” button
to load the value into the list. The user may remove a contour value
by highlighting the value in the list and depressing the “Remove”
button.

The maximum number of entries is 20. This input must be a

positive numeric value greater than or equal to 0.0001 (m2/kg) and
less than or equal to 1000.0 (mzlkg). Decimal values are valid.
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The “Reset” button will clear all input values from the dialog.

Depressing the “Plot” button sends input values from the dialog to the calculating routines. As the
utility processes the data, a Processing dialog will appear. To cease processing, depress the “Stop”
button on the dialog.

If no points are calculated, a message box will appear notifying the user. The user must then select
“OK” to exit the message box.

Output Data:

The generated plot is viewable in a separate plot window. Delta-V (m/s) is along the vertical axis
and Altitude (km) is along the horizontal axis. On the plot, A/M increases from the top and left
toward the bottom and right. Section 2.6, Using the Plot Viewer provides information on plot
utility functions. The underlying data are automatically saved as file plots/DecayL.ifetime.dpl.
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Plot 6 - Delta-V for Decay Orbit Given Orbital Lifetime
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4.4.2 Delta-V for Decay Orbit, Given Area-to-Mass

This utility plots Orbital Lifetime contour points corresponding to the Delta-V required to move an
object, with specified area-to-mass ratio, from an initial circular low Earth orbit to a decay orbit.
The user specifies a list of Orbital Lifetime contour values. The plot allows the user to explore the
cost of deorbiting a vehicle over a range of decay lifetimes. Figure 4-10 shows the input dialog, and
Table 4-12 describes the values.
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Figure 4 - 10: Delta-V for Decay Orbit Given Area-To-Mass Dialog
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Table 4 - 12: Delta-V for Decay Orbit Given Area-To-Mass Input Data

Start Year The beginning date (in decimal years) for the time period currently
under study. The input must be a positive numeric value equal to or
greater than 2010 and less than or equal to 2070. In addition, the
sum of the Start Year and the Orbital Lifetime must not exceed the
year 2070.

Area-To-Mass The area-to-mass ratio is the object’s average cross-sectional area

(mz) divided by its final mass (kg). The input must be a positive
numeric value greater than or equal to 0.00001 (mzlkg) and less

than or equal to 1000 (m2/kg). Decimal entries are valid.

Orbit Lifetime Each Orbital Lifetime contour value is entered into the edit box
below the list. Once entered, the user depresses the “Add” button
to load the value into the list. The user may remove a contour value
by highlighting the value in the list and depressing the “Remove”
button.

The maximum number of entries is 20. The input value must be a
positive numeric value greater than or equal to 0.01 (yr) and less
than or equal to 10000.0 (yr); however, the sum of Orbital Lifetime
and Start Year must not exceed 2070.

The “Reset” button will clear all input values from the dialog.

Depressing the “Plot” button sends input values from the dialog to the calculating routines. As the
utility processes the data, a Processing dialog will appear. To cease processing, depress the “Stop”
button on the dialog.

If no points are calculated, a message box will appear notifying the user. The user must then select
“OK?” to exit the message box.

Output Data:
The generated plot is viewable in a separate plot window. Delta-V (m/s) is along the vertical axis
and Altitude (km) is along the horizontal axis. On the plot, orbital lifetime increases from the top

and left toward the bottom and right. Section 2.6, Using the Plot Viewer provides information on
plot utility functions. The underlying data are automatically saved as file plots/DecayAOM.dpl.

72



Delta-vt
{m/s)
a00.0

450.0

400.0

350.0

300.0

250.0

200.0

150.0

100.0

50.0

0.0

Delta-V for Decay Orbit Given Area-To-Mass
(Contours of Decay Orbit Lifetime)

Start Year = 2005 .20 yr
Area-To-Mass = 0.007 yr=

W01 Orbital Lifetime:
Moz Orbital Litetime:
W02 Orbital Lifetime:
04 Orbital Lifetime:
W05 Orbital Lifetime:
06 Orbital Lifetime:
W07 Orbital Lifetime:
02 Orbital Lifetime:

0.1ty
002 ()
0.5 (yn)
0.10 fyn)
0.20 (yr)
0.50 (v
1.00 ()
2.00 iy

200.0

600.0 1000.0 1400.0
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4.5 Delta-V for Orbit-to-Orbit Transfer

This Science and Engineering Utility may assist users in the assessment of compliance with
Requirement 4.6, the “postmission disposal of space structures.” This utility calculates the
minimum change in velocity required to maneuver from one orbit to a second, co-planar orbit.
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45.1 Orbit-to-Orbit Transfer

This utility calculates the Delta-V required for a coplanar orbit transfer. Figure 4-11 shows
input/output dialog, and Tables 4-13 and 4-14 describes the values, respectively.

Delkay for Orbit-To-0rbit Transfer

| put
First Orbit Perigee Altitude 1007 ko
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Figure 4 - 11: Delta-V for Orbit-to-Orbit Transfer Dialog
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Input Data:
Table 4 - 13: Delta-V for Orbit-to-Orbit Transfer Input Data

First Orbit Perigee Altitude The perigee altitude (in kilometers) for the object
currently under study, immediately before the orbit
transfer maneuver. The input must be a positive
numeric value greater than 90 and less than or equal
to 100,000. In addition, the perigee altitude must be
less than or equal to the apogee altitude.

First Orbit Apogee Altitude The apogee altitude (in kilometers) for the object
currently under study, immediately before the orbit
transfer maneuver. The input must be a positive
numeric value greater than 90 and less than or equal
to 100,000. In addition, the apogee altitude must be
equal to or greater than the perigee altitude.

Second Orbit Perigee Altitude | The final (destination) perigee altitude (in kilometers)
for the object currently under study. The input must
be a positive numeric value greater than 90 and less
than or equal to 100,000. In addition, the perigee
altitude must be less than or equal to the final apogee
altitude.

Second Orbit Apogee Altitude | The final (destination) apogee altitude (in kilometers)
for the object currently under study. The input must
be a positive numeric value greater than 90 and less
than or equal to 100,000. In addition, the apogee
altitude must be equal to or greater than the final
perigee altitude.

The “Reset” button will clear all input values from the dialog. The “Run” button sends the user
input to the calculating routines. If input values are valid the output fields will display the
calculated results.

Table 4 - 14: Delta-V for Orbit-to-Orbit Transfer Output Data

Transfer Orbit Perigee The perigee altitude attained after Delta-V (first burn).
Transfer Orbit Apogee The apogee altitude attained after Delta-V (first burn).
Delta-V (First Burn) First Burn Delta-V is the Delta-V required to place the

object on the minimum-energy transfer orbit connecting
the first and second orbits.

Delta-V (Second Burn) Second Burn Delta-V is the Delta-V required to move
the object from the transfer orbit to the second
(destination) orbit.

Delta-V (Total) Total Delta-V is the total Delta-V required to maneuver
the object from first to second orbit, using a two-burn,
minimum-energy transfer. This quantity represents the
sum of the first and second burn Delta-Vs.
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4.6 Other Utilities

Utilities not directly related to specific requirements are provided to support the definition of data
related to orbital mechanics.

4.6.1 Two Line Element Converter

This utility provides the user with a means to convert a two-line element (TLE) set into orbital
parameters that can be used in DAS.

TLE Corvverter

1 255447 930674 0624 . 98973818 000130759 00000-0
2 25544 051.6315 162.0771 0011080 283 .4941 127 5826

£ *
Fezet | Help | Load fram File
DAS Inputs
Year  |2006

Cay of Year |242.330
Decimal Year  |2006.686
Semi-Major Ais (k) (B721.133
Eccentricity  |0.001108
Ferigee Alt. [km]  |335.610
Apogee Al [km]  |350.504
Inclination [deqg] |51.632
RasM [degl |162.077
Arg, of Perigee [deg] |283.494
Mean Anomaly [degl  [127.5383

EEREEEEEELN

Figure 4 - 12: Two Line Element Conversion Dialog
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Input Data:

The TLE converter has only one input area: the edit box at the top of the window. The TLE text
can be hand typed, pasted from the clipboard, or loaded from a file. When loading from a file, this
utility converts only the first valid TLE set it finds.

A two-line element set consists of two, 69-character lines of data which can be used to determine
the position and velocity of an object orbiting Earth. Below is a reference chart for the fields in a
two-line element set.

Table 4 - 15: Two-Line Element Set Format Definition, Line 1

Field Column Description

1.1 01 Line Number of Element Data

1.2 03-07 Satellite Number

1.3 08 Classification

1.4 10-11 International Designator (Last two digits of launch year)

15 12-14 International Designator (Launch number of the year)

1.6 15-17 International Designator (Piece of the launch)

1.7 19-20 Epoch Year (Last two digits of year)

1.8 21-32 Epoch Day (Day of the year and fractional portion of the day)

1.9 34-43 One-half the First Time Derivative of the Mean Motion

1.10 45-52 One-sixth the Second Time Derivative of Mean Motion (decimal point
assumed)

1.11 54-61 BSTAR drag term (decimal point assumed)

1.12 63 Ephemeris type

1.13 65-68 Element number

1.14 69 Checksum (Modulo 10) (Letters, blanks, periods, plus signs=0; minus signs=1)

Table 4 - 16: Two-Line Element Set Format Definition, Line 2

Field Column Description

2.1 01 Line Number of Element Data

2.2 03-07 Satellite Number

2.3 09-16 Inclination [Degrees]

2.4 18-25 Right Ascension of the Ascending Node [Degrees]

2.5 27-33 Eccentricity (decimal point assumed)

2.6 35-42 Argument of Perigee [Degrees]

2.7 44-51 Mean Anomaly [Degrees]
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Table 4 - 17 - Continued

Field Column Description
2.8 53-63 Mean Motion [Revs per day]

2.9 64-68 Revolution number at epoch [Revs]
2.10 69 Checksum (Modulo 10)

Output Data:

DaS Inputs
Year |2006

Dayof Year (242990
Decimal Year  |2006.EEE
Semi-Major Asiz (km]  |B721.133
Eccentricity  10.001102
Ferigee Al (k] 335610
Apogee Al [km] (350504
Inclnation [deg] |51.632
RadM [deg] 162077
Arg. of Perigee [deg] 2834934
Mean Anomaly [deg]  |127.583

EELLEEEE LN

Figure 4 - 13: Elements Converted to DAS Input Values

The DAS Input Area displays the values that are obtained from running the TLE Converter. These
values will be useful for specifying the orbital parameters needed throughout the DAS.

4.6.2 Calculate Cross-Sectional Area

This Science and Engineering Utility may assist users in estimating the effective cross-sectional
area of a structure. This quantity is divided by the structure’s mass to produce the area-to-mass
ratio, used in Requirement assessment.

This utility provides a means to create a “wire-frame” model of a spacecraft and to estimate the
average cross-sectional area of a spacecraft. This cross-sectional area can be used to calculate the
area-to-mass ratio entry in the DAS Mission Editor. For many projects, this tool will not need to be
used; it is included here to augment the standard area estimation techniques outlined in Section 4.5
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of the NASA-STD-8719.14A. Subsection 4.5.4.1 of the Standard gives simple methods for
estimating an object’s average cross-sectional area.

The model is constructed using a series of triangles, cylinders, and spheres. The wire-frame plot
feature may be used to check for errors in data entry. The cross-sectional area estimation tool is

intended to provide a basic, but reasonably accurate, estimate of average cross-sectional area. The
fidelity of the result will depend upon the level of detail provided by the user. Figure 4-12 shows

the input/output dialog.

— Calculate Crozz-Sectional Area

— Input
Fandom Tumbling j Orientation
Component Point 1 | Point 1 | Point 1 | Point 2 | Point 2 | Point 2 | Point 3 | Point 3 | Point 3 | Radius 1 | Radius 2
Row |Shape LUy WUy | LUy Oy | vy | Uy Loy ) vouy e uu) |y Ly
1 Cylinder o a a a 0 1 8 .5
2 |sphere =lo 0 0 5
3 |sphere =lo 0 1 5
= Triangle ;I 0 2 375 4] -2 625 1] 2 625
5 Triangle LI o} 2 375 a -2 625 u} -2 375
= =l
Bun | Rezet | Help | Flat
Cutput
Crozs-Sectional Area [1.90 [LU"2 LU = Length Unit
Figure 4 - 14: Calculate Cross-Sectional Area Dialog
Input Data:

The user must first define the spacecraft’s orientation as being “random tumbling,” “gravity
gradient,” or “fixed orientation.”

Random tumbling — No axes will be fixed during the orbital lifetime in question.

Gravity gradient — The gravity (nadir) direction will be maintained with respect to the
spacecraft during the orbital lifetime in question.

Fixed orientation — The velocity (ram) direction and gravity (nadir) direction will be
maintained with respect to the spacecraft during the orbital lifetime in question.
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For objects that are “gravity gradient” or have “fixed orientation,” the coordinate system shall be
defined as U, V, and W, where +U is “up” (the opposite direction from gravity), +V is in the
direction of velocity, and W is “port” (orthogonal: UxV).

Component data are entered into the input grid by typing in any field in the last line of the grid
(labeled as row “*”). Users input values for shape, point coordinates, and radius as required. The
units need only be consistent, as the resulting units of area are simply the square of the input length
(position) units. Note that this module can process a maximum of 1000 objects.

Component shapes are defined as follows:

e Triangles— U, V, and W for three corner points are needed. For square or rectangular
surfaces, two adjoining triangles must be entered. While this is a tedious way to enter the
data, it is necessary to ensure that each surface remains in a plane, a requirement of the
cross-sectional area estimation software. For thin plates, such as solar panels, the thickness
may be ignored.

e Cylinders—U, V, and W for the center points and radii of each end disk are needed. The
cylinder may have end disks of different radii. A cone would have one end disk with a
radius of 0. A flat disk can be entered as cylinder with a minimal distance between the two
end disks.

e Spheres— U, V, and W for the center and its radius are needed.

Triangles are two-dimensional, while cylinders and spheres are three-dimensional. Surfaces that are
interior to another surface will not affect the cross-sectional area estimation. For example, if the
center point for a sphere is identical to one of the end points for a cylinder, only the portion of the
sphere that is exterior to the cylinder will be considered. Surfaces that are entirely interior do not
need to be defined.

If the configuration of the object can change (i.e., moving solar panels), the average of cross-
sectional area over each anticipated configuration may be used, based upon an intelligent
assumption about the expected time spent in each configuration.

For more detailed projects, the user might find it useful to edit the comma separated value (CSV)
file xsectional.csv within the Project directory, rather than use the graphical user interface.

The “Reset” button will clear all input values from the dialog.
Depressing the “Plot” button sends input values from the dialog to the plotting tool.
The purpose of the plotting tool is to provide a basic “sanity check” of the input values. This visual

depiction should assist the user in constructing the objects for cross-sectional evaluation, but it is
not necessary for actual calculation of cross-sectional area.
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The plotting tool generates three, two-dimensional plots showing the V-W (top), V-U (side), and
W-U (front) orthogonal views of the triangles, cylinders, and spheres used to define the spacecraft.
However, because of the difficult nature of showing complex, three-dimensional objects in two-
dimensional plots, there are two basic limitations:

1. To be plotted, the axis of a cylinder (i.e., the line between the centers of the two end disks)
must be defined in only one or two of the three user-defined UVW directions. If the axis of
a cylinder varies in the U, V, AND W directions, it will be omitted on the graph. Itis
important to note, the omission does NOT affect the cross-sectional area calculation. All
cylinders, regardless of their orientation, will be considered when the cross-sectional area is
estimated.

2. For visual clarity, all points interior to a perfect cylinder (end disk radii identical) will be
removed if the axis of the cylinder is in a primary (U, V, or W) direction only. Any cylinder
axis in two directions or any cylinder with end disks of different radii will not “hide” any
interior points. All points interior to a sphere will be removed for visual clarity, as well.

Output Data:

Output is the average projected cross-sectional area of the defined object. Output units are the
square of the input units.

By clicking the “Plot” button, the user may generate a three-view representation of the wire-frame
model. The generated plot is viewable in a separate plot window. This is useful for finding data-
entry errors that may have occurred during definition of the model points. Section 2.6, Using the
Plot Viewer provides information on plot utility functions.
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Plot 8 - Three-View Cross-Sectional Area Plot

Note: Depending on the size and complexity of the object, the process may take several minutes to
converge upon a result.
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Appendix A: Glossary of Terms and Acronyms

Aero mass — The aerodynamic mass of an object is the mass of that specific object plus the mass of
all internal fragments. Consequently, the aero mass must be at least equal to the object’s
mass.

Altitude — The height above Earth’s surface (distinguished from radius, measured from Earth’s
center).

Apogee — The point on the orbit that is the farthest from the center of Earth. The apogee altitude is
the distance of the apogee point above the surface of Earth.

Apsis (pl. apsides) — The point in the orbit where a satellite is at the lowest altitude (perigee) or at
the highest altitude (apogee). The line connecting apogee and perigee is the line of apsides.

Area-to-Mass ratio (AOM, A/M) — The area-to-mass ratio, which is a measurement of the effective
cross-sectional area of an orbiting object divided by its mass. Normal units are square
meters per kilogram. Higher AOM will yield faster decay for LEO objects, while lower
AOM (a more dense object) yields slower decay. AOM should include deployed surfaces
(e.g. solar panels).

Argument of perigee — The angle between the line extending from the center of Earth to the
ascending node of an orbit and the line extending from the center of Earth to the perigee
point in the orbit, measured from the ascending node in the direction of motion of the
satellite.

Ascending node — The point in the orbit where a satellite crosses Earth’s equatorial plane in passing
from the southern hemisphere to the northern hemisphere.

Casualty — Injury to a person on the surface of Earth, caused by being struck by an object with
kinetic energy of 15 Joules or greater.

Combo box — A GUI component with a drop-down arrow that users click to display an associated
list of choices. The current selection appears in an editable or noneditable text field next to
the drop-down arrow. The user displays the list by clicking or dragging the drop-down
arrow.

Cratering flux — The number of impacts per square meter per year of objects which will leave a
crater at least as large as a specified diameter.

Critical surface — A surface in a component of a payload that, when the surface is damaged by
impact, will cause the component to fail.

Debris flux — The number of impacts per square meter per year expected on a randomly-oriented
planar surface of an orbiting space structure.
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Debris flux to limiting size — The number of impacts per square meter per year of debris objects of a
specified diameter or larger.

Delta-V, AV — The change in the velocity vector caused by thrust, measured in units of meters per
second.

Demise — The total destruction of a reentering object, caused mainly by frictional heating with the
atmosphere.

Dialog — A top-level GUI window, with a title and a border, that is typically used to take some form
of input from the user.

Disposal orbit — The final orbit of an object after a completed mission. The project may elect to
alter the end-of-mission orbit via a maneuver to a disposal orbit so that it may satisfy
Requirement 4.6.

Eccentricity — A measure of an orbit’s ellipticity, calculated as the orbit’s apogee altitude minus its
perigee altitude, divided by twice its semimajor axis. Eccentricity is zero for circular orbits
and less than one for all elliptical (i.e. bound) orbits.

F10.7 — An index of solar activity; typically a 13-month running average of the energy flux from
the Sun measured at a wavelength of 10.7 cm, expressed in units of 10* Janskys or Solar
Flux Units (sfu).

Final mass — The expected mass after all propellants and fluids have been burned or vented and all
mission related debris have been released.

Geosynchronous orbit (GEO) — An orbit with a period equal to the sidereal day. A circular GEO
orbit with 0° inclination is a geostationary orbit, i.e., the sub-satellite point is at a fixed
longitude on Earth’s equator. The altitude of a circular GEO orbit is 35,786 km.

Geosynchronous transfer orbit (GTO) — A highly eccentric orbit with perigee within or near LEO
altitude and apogee near or above GEO altitude.

Grid — A GUI control to display the fields of a data source as columns in a table. Each row in the
control represents a record in the data source.

GUI — Graphical user interface for computer software. The dialog window provided for user
interface with an application’s functional process.

High Earth Orbit, High Altitude Orbit (HEO) — An orbit with a mean altitude greater than 2000 km
or, equivalently, an orbit with a period greater than 127 minutes.

Inclination — The angle an orbital plane makes with Earth’s equatorial plane.

Initial mass — The mass of the object at the beginning of the mission, including propellants.



Jansky — A unit of electromagnetic power density equal to 10-2° watts/m?/Hz.

Launch (GUI) — An action within a GUI dialog causing an additional dialog to open for user
application interface.

Launch vehicle — Any space transportation mode, including expendable launch vehicles (ELVS),
reusuable launch vehicles (RLVs), and the Space Shuttle.

Line of apsides — The line connecting the apogee and perigee points in an orbit. This line passes
through the center of Earth.

Line of nodes — The line formed by the intersection of the orbit plane with Earth’s equatorial plane.
This line passes through the center of Earth. The ascending node is the point where a
satellite crosses the equator from the southern hemisphere to the northern hemisphere.

Low Earth Orbit (LEO) — The region of space below the altitude of 2000 km.

Mean anomaly — An angle measure, the product of the orbiting object’s mean motion (mean angular
rate) and the time since periapse passage.

Medium Earth Orbit (MEO) — An orbit (or the region itself) between LEO and GEO.

Meteoroids — Naturally occurring particles associated with solar system formation or evolution
processes. Meteoroid material is often associated with asteroid breakup or material
released from comets.

Mission duration — The length of time that a mission is actively supported by ground operations.

Near-GEO — An orbit that has low eccentricity and both the perigee and apogee points are within
the altitude range of (GEO-500 km) and (GEO+300 km).

NOAA — The National Oceanic and Atmospheric Administration, part of the U.S. Department of
Commerce. NOAA’s Space Environment Center provides historical and predicted solar flux
data.

Operational orbit — The orbit of an object during its primary (and extended) missions.

Orbital lifetime — The length of time an object remains in orbit. Objects in LEO or passing
through LEO lose energy as they pass through Earth’s upper atmosphere, eventually
getting low enough in altitude that the atmosphere removes them from orbit.

Orbital debris — Man-made objects, including inactive spacecraft and spent launch vehicle orbital
stages, left in orbit. In this document, only debris of diameter 1 mm and larger are
considered.

Orbital stage — A part of the launch vehicle left in a parking, transfer, or final orbit during payload
insertion; includes both liquid propellant systems and solid rocket motors and any
propulsive unit ejected from a spacecratft.



ORDEM — NASA’s Orbital Debris Engineering Model. This is a statistical model, based on
observations, that describes the orbital debris environment between 200 and 2000 km
altitude. DAS 2.1 uses ORDEM 3.0, which describes the orbital debris environment
between the altitudes of 100 and 40,000 km. NOTE: Increased fidelity of the ORDEM 3.0
comes at the cost of greatly-increased DAS run times.

ORSAT — The Object Reentry Survival Analysis Tool, NASA’s computer code for predicting the
reentry survivability of satellite and launch vehicle upper-stage components entering from
orbital decay or from controlled entry.

Penetration debris flux — The number of impacts per square meter per year that will penetrate a
surface of specified orientation with specified materials and structural characteristics.

Perigee — The point in the orbit that is nearest to the center of Earth. The perigee altitude is the
distance of the perigee point above the surface of Earth.

Right ascension of ascending node — The angle between the line extending from the center of Earth
to the ascending node of an orbit and the line extending from the center of Earth to the
vernal equinox, measured from the vernal equinox eastward in Earth’s equatorial plane.

Semimajor axis — Half the sum of the distances of apogee and perigee from the center of Earth.
Half the length of the major axis of the elliptical orbit.

Semisynchronous Orbit (SSO) — An orbit with approximately a 12-hour period. A circular SSO is at
an altitude of 20,200 km.

Solar flux unit (sfu) — Equal to 104 Janskys measured at a wavelength of 10.7 cm.
Space debris — Either meteoroid or orbital debris.

Stabilized — When the spacecraft maintains its orientation relative to some external frame of
reference.

Station-Keeping — During its mission duration, the payload is precluded from natural orbital decay
by active station-keeping devices, e.g. thrusters.

Thermal mass — The thermal mass is strictly the mass of one specific object. This is the mass used
for determining how much material needs to burn up.

Vernal equinox — The direction of the Sun in space when it passes from the southern hemisphere to
the northern hemisphere (on March 20 or 21) and appears to cross Earth’s equator. The
vernal equinox is the reference point for measuring angular distance along Earth’s
equatorial plane (right ascension). It is one of two angles usually used to locate objects in
orbit (the other being declination).

Wet/Dry mass — Wet mass is the mass of an object (payload or orbital stage) including propellant or
any other expendable fluid, while dry mass is the mass of an object less any expendables.



Appendix B: NASA Technical Standard 8719.14A Requirements

4.3. REQUIREMENTS FOR THE CONTROL OF DEBRIS RELEASED
DURING NORMAL OPERATIONS

Orbital debris analyses assess the amount of launch vehicle and spacecraft debris released in normal
operations. This requirement area applies to all space structures while in Earth orbit and is
recommended for lunar and Mars orbital operations.

NASA space programs and projects shall assess and limit the amount of debris released.

REQUIREMENTS

4.3-1. Debris passing through LEQO: For missions leaving debris in orbits passing through LEO,
released debris with diameters of 1 mm or larger shall satisfy both Requirement 4.3-1a and
Requirement 4.3-1b:

4.3-1a. All debris released during the deployment, operation, and disposal phases shall be limited
to a maximum orbital lifetime of 25 years from date of release.

4.3-1b. The total object-time product shall be no larger than 100 object-years per mission. The
object-time product is the sum of all debris of the total time spent below 2000 km altitude
during the orbital lifetime of each object.

4.3-2. Debris passing near GEO: For missions leaving debris in orbits with the potential of traversing
GEO (GEO altitude +/- 200 km and +/- 15 degrees latitude), released debris with diameters of 5 cm
or greater shall be left in orbits which will ensure that within 25 years after release the apogee will
no longer exceed GEO - 200 km.

B-1



4.4. ASSESSMENT OF DEBRIS GENERATED BY EXPLOSIONS
AND INTENTIONAL BREAKUPS

Orbital debris analyses assess accidental explosion probability and intentional breakups during and
after completion of mission operations. Requirements 4.4-1, 4.4-1, and 4.4-3 are required for all
space structures in Earth and lunar orbits. Requirement 4.4-3 is recommended for Earth-Sun
Lagrange points, Earth-Moon Lagrange points, and Mars operations.

NASA space programs and projects shall assess and limit the probability of accidental spacecraft
and launch vehicle orbital stage explosion during and after completion of deployment and mission
operations.

REQUIREMENTS

4.4-1.

4.4-2.

Limiting the risk to other space systems from accidental explosions during deployment and mission
operations while orbital about Earth or the Moon: For each spacecraft and launch vehicle orbital
stage employed for a mission, the program or project shall demonstrate, via failure mode and
effects analyses or equivalent analyses, that the integrated probability of explosion for all credible
failure modes of each spacecraft and launch vehicle is less than 0.001 (excluding small particle
impacts).

Design for passivation after completion of mission operations while in orbit about Earth or the
Moon: Design of all spacecraft and launch vehicle orbital stages shall include the ability and a plan
to deplete all onboard sources of stored energy and disconnect all energy generation sources when
they are no longer required for mission operations or postmission disposal or control to a level
which can not cause an explosion or deflagration large enough to release orbital debris or break up
the spacecraft.

NASA space programs and projects shall assess and limit the effect of intentional breakups of
spacecraft and launch vehicle orbital stages on other users of space.

REQUIREMENTS

4.4-3. Limiting the long-term risk to other space systems from planned breakups: Planned explosions or

intentional collisions shall:

a) Be conducted at an altitude such that for orbital debris fragments larger than 10 cm the object-
time product does not exceed 100 object-years. For example, if the debris fragments greater
than 10 cm decay in the maximum allowed 1 year, a maximum of 100 such fragments can be
generated by the breakup.

b) Not generate debris larger than 1 mm that shall remain in Earth orbit longer than one year.

4.4-4. Limiting the short-term risk to other space systems from planned breakups: Immediately before a

planned explosion or intentional collision, the probability of debris, orbital or ballistic, larger than
1 mm colliding with any operating spacecraft within 24 hours of the breakup shall be verified to not
exceed 1076
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4.5. ASSESSMENT OF DEBRIS GENERATED BY
ON-ORBIT COLLISIONS

Orbital debris analyses assess the ability of the design and mission profile of a space system to limit
the probability of accidental collision with known resident space objects during the system’s orbital
lifetime. Requirement 4.5 shall apply for all space structures in Earth and lunar orbits.

NASA space programs and projects shall assess and limit the probability that the operating space
system becomes a source of debris if it collides with orbital debris or meteoroids.

REQUIREMENTS

4.5-1. Limiting debris generated by collisions with large objects when operating in Earth orbit: For each
spacecraft and launch vehicle orbital stage in or passing through LEO, the program or project shall
demonstrate that, during the orbital lifetime of each spacecraft and orbital stage, the probability of
accidental collision with space objects larger than 10 cm in diameter is less than 0.001.

4.5-2. Limiting debris generated by collisions with small objects when operating in Earth or lunar orbit:
For each spacecraft, the program or project shall demonstrate that, during the mission of the
spacecraft, the probability of accidental collision with orbital debris and meteoroids sufficient to
prevent compliance with the applicable postmission disposal requirements is less than 0.01.
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4.6. POST MISSION DISPOSAL OF SPACE STRUCTURES

NASA space programs and projects shall plan for the disposal of spacecraft and launch vehicle
orbital stages and space structures at the end of their respective missions. Postmission disposal
shall be used to remove a space structure from Earth orbit in a timely manner or to leave a space
structure in a disposal orbit where the structure will pose as small a threat as practical to other
space systems.

REQUIREMENTS

4.6-1. Disposal for space structures in or passing through LEQO: A spacecraft or orbital stage with a
perigee altitude below 2000 km shall be disposed of by one of the following three methods:

a. Atmospheric reentry option:
e Leave the space structure in an orbit in which natural forces will lead to atmospheric reentry
within 25 years after the completion of mission but no more than 30 years after launch; or
e Maneuver the space structure into a controlled de-orbit trajectory as soon as practical after
completion of mission.

b. Storage orbit option: Maneuver the space structure into an orbit with perigee altitude greater
than 2000 km and apogee less than GEO - 500 km.

c. Direct retrieval: Retrieve the space structure and remove it from orbit within 10 years after
completion of mission.

4.6-2. Disposal for space structures near GEQ: A spacecraft or orbital stage in an orbit near GEO shall
be maneuvered at EOM to a disposal orbit above GEO with a predicted minimum perigee of GEO +
200 km (35,986 km) or below GEO with an apogee of GEO — 200 km (35,586 km) for a period of
at least 100 years after disposal.

4.6-3. Disposal for space structures between LEO and GEO:

a. A spacecraft or orbital stage shall be left in an orbit with a perigee greater than 2000 km above
the Earth’s surface and apogee less than 500 km below GEO.

b. A spacecraft or orbital stage shall not use nearly circular disposal orbits near regions of high
value operational space structures, such as between 19,200 km and 20,700 km.

4.6-4. Reliability of postmission disposal operations in Earth orbit: NASA space programs and projects
shall ensure that all postmission disposal operations to meet Requirements 4.6-1, 4.6-2, and/or 4.6-3
are designed for a probability of success as follows:

a. Be no less than 0.90 at EOM.

b. For controlled reentry, the probability of success at the time of reentry burn must be sufficiently
high so as not to cause a violation of Requirement 4.7-1 pertaining to limiting the risk of human
casualty.
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4.7. SURVIVAL OF DEBRIS FROM THE POST-MISSION DISPOSAL
ATMOSPHERIC REENTRY OPTION

Orbital debris analyses assess the risks associated with the disposal of a space vehicle in Earth’s
atmosphere. This area applies to full spacecraft as well as jettisoned components. Requirement
area 4.7 applies to all space structures in Earth orbital area returning to the surface of the Earth from
an altitude of greater than 100 km (~62 mi).

NASA space programs and projects that use atmospheric reentry as a means of disposal for
space structures need to limit the amount of debris that can survive reentry and pose a threat to
people on the surface of the Earth.

REQUIREMENTS

4.7-1. Limit the risk of human casualty: The potential for human casualty is assumed for any object with
an impacting kinetic energy in excess of 15 Joules.

a. For uncontrolled reentry, the risk of human casualty from surviving debris shall not exceed
0.0001 (1:10,000).

b. For controlled reentry, the selected trajectory shall ensure that no surviving debris impact with a
kinetic energy greater than 15 Joules is closer than 370 km from foreign landmasses, or is
within 50 km from the continental U.S., territories of the U.S., and the permanent ice pack of
Antarctica.

c. For controlled reentries, the product of the probability of failure of the reentry burn (from
Requirement 4.6-4.b) and the risk of human casualty assuming uncontrolled reentry shall not
exceed 0.0001 (1:10,000).
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4.8. ADDITIONAL ASSESSMENT REQUIREMENT FOR
TETHER MISSIONS

Orbital debris analyses assess the potential hazard of tethered systems considering both an intact
and a severed system. Tethers are flexible, long, and narrow space structures with two of the
dimensions much smaller than the third. The potential to damage operating spacecraft can be larger
than would be expected solely from the tether mass and cross-sectional area. Due to the potential of
tether systems being severed by orbital debris or meteoroids, all possible remnants of a severed
tether system shall be compliant with the requirements for the collision, debris, and disposal of

space structures. Requirement area 4.8 applies to all space structures using tethers in Earth or lunar
orbits.

NASA programs and projects shall assess and limit the collision hazard posed by tether systems
on other users of space and on the near-Earth environment.

REQUIREMENTS

4.8-1. Mitigate the collision hazards of space tethers in Earth or Lunar orbits: Intact and remnants of
severed tether systems in Earth and lunar orbit shall meet the requirements limiting the generation
of orbital debris from on-orbit collisions (Requirements 4.5-1 and 4.5-2) and the requirements
governing postmission disposal (Requirements 4.6-1 through 4.6-4) to the limits specified in those
paragraphs.




Appendix C: DAS 2 Technical Notes

C.1  Propagators

DAS 2 uses the NASA propagators “PROP3D” and “GEOPROP”. GEOPROP calculates the
motion of objects in geosynchronous orbits, while PROP3D calculates the orbits of all other objects.
A geosynchronous orbit is defined as having orbital eccentricity less than 0.1, inclination less than
15°, and period between 0.95 and 1.05 days. The propagators are designed to maintain integration
accuracy over long propagation periods (decades) with reasonable computation speed.

Both propagators account for all significant perturbing forces. Table C-1 lists the perturbations and
some of the reference models used. PROP3D propagates five orbital elements, describing the shape
and orientation of the orbit, but not the position of the object along that orbit. GEOPROP

propagates all six orbital elements, based on the disturbing-function formulation of VVan der Ha [1].

Table C - 1: Perturbations included in the DAS orbit propagators

Perturbation PROP3D GEOPROP
Atmospheric drag Oblate, rotating None
atmosphere [2, 3]
Solar & Lunar gravity Yes [4] Yes
Solar radiation pressure (SRP) | Yes Yes
Earth’s shadow for SRP Yes Neglected
Earth’s gravity field Zonal harmonics: Jz, J3, | Zonal harmonics: Jz, Js, Ja
Ja, (32)? [5] Tesserral harmonics: J22, J31,
J33, Ja2, Jaa

For DAS 2, the coefficient of drag is assumed to be 2.2. The coefficient of reflectivity (for the solar
radiation pressure perturbation) is assumed to be 1.25. For example, a perfectly transparent object
would have a coefficient of reflectivity of zero, while a planar mirror normal to the (solar) flux
would have a coefficient of 2.0.

1. Van der Ha, J.C., “Long-term evolution of near-geo orbits,” J. Guidance, 9, p. 363-370, 1986.

2. Jacchia, L.G., Thermospheric Temperature, Density and Composition: New Models, Smithsonian
Astrophysical Observatory, Special Report 375, 1977.

3. King-Hele, D., Satellite Orbits in an Atmosphere, Blackie & Son, LTD., London, 1987.

4. Cook, G.E., “Luni-solar perturbations of the orbit of an Earth satellite,” The Geophysical Journal
of the Royal Astronomical Society, 6, p. 271-291, 1962.

5. Vallado, D.A., Fundamentals of Astrodynamics and Applications, McGraw-Hill, NY, 1997.
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C.2  Orbital Elements

Orbital elements are mathematical quantities used to describe the path (trajectory) of an object
traveling through space. DAS 2 uses a set of Keplerian orbital elements. Figures C-1 and C-2
depict the physical nature of the elements, which are listed in Table C-2. One common format of
the orbital elements is the “two-line element” (TLE) format, described in Sect. 4.6.1 of this Guide.
For more information, the reader should consult any basic celestial mechanics textbook.

ae

Figure C - 1: Orbital Elements in the Orbital Plane
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Figure C - 2: Orbital Elements

Table C - 2: Description of the Orbital Elements

Orbital Element

Symbol

Description

Semi-major axis

a

Half the sum of the distances of apogee and perigee
from the center of Earth. Half the length of the
major axis of the elliptical orbit.

Eccentricity

A measure of an orbit’s ellipticity, calculated as the
orbit’s apogee altitude minus its perigee altitude,
divided by twice its semimajor axis.

Inclination

The angle an orbital plane makes with Earth’s
equatorial plane.

Right ascension of the
ascending node

The angle between the line extending from the center
of Earth to the ascending node of an orbit and the
line extending from the center of Earth to the vernal
equinox, measured from the vernal equinox eastward
in Earth’s equatorial plane.

Argument of perigee

The angle between the line extending from the center
of Earth to the ascending node of an orbit and the
line extending from the center of Earth to the perigee
point in the orbit, measured from the ascending node
in the direction of motion of the satellite.

Mean anomaly
(not pictured)

An angle measure: the product of the orbiting
object’s mean motion (mean angular rate) and the
time since periapse passage.




C.3  Orbital Debris Environment Model

DAS 2.1 incorporates the orbital debris environment model of ORDEM 3.0, the Orbital Debris
Engineering Model also developed by the NASA Orbital Debris Program Office. This is the only
major change in this version. The higher-fidelity ORDEM 3.0 has greatly increased run-times
compared to the previous ORDEM2 (a.k.a. ORDEMZ2000). Because DAS performs an ORDEM
analysis for each year an object is in orbit, these increased run-times are multiplied. DAS runs that
formerly lasted minutes will now take substantially longer. Highly elliptical orbits, crossing a wider
parameter space, will see the greatest increase in run-time.

The ORDEM 3.0 debris populations have been simplified to reduce storage requirements and
computation times. Debris sizes below 316 um are excluded, and the time period from 2036 to
2070 (the ORDEM 3.0 time period is 2010-2035) does not include small debris (i.e., sizes below 10
cm). An important result of this is that DAS cannot assess Requirement 4.5-2 for missions
operating after 2035. This shortcoming shall be addressed in a future version of DAS.

In DAS, three Assessments and three Science and Engineering routines use functions derived from
ORDEM 3.0. The increase in run-time depends on the number of times DAS must call the ORDEM
functions. Due to the large number of ORDEM runs, users may find the On-Orbit Collisions
plotting tools impractical.

Table C - 3: DAS Functions that use ORDEM

DAS function Number of times ORDEM routines are called

Assessment of Requirement 4.5-1: Once for every calendar year in orbit (not just
Limiting Debris Generated by Collisions | mission lifetime)
with Large Objects [orbital lifetime x 1]

Assessment of Requirement 4.5-2: Once for every calendar year of mission
Probability of Damage from Small Debris | lifetime

[mission lifetime x 1]

Assessment of Requirement 4.8-1.: Twice for every calendar year in orbit (not
Mitigate the Collision Hazard of Space just mission lifetime): once each for Req.
Tethers 4.5-1 and Req. 4.5-2

[orbital lifetime x 2]

Sci & Eng — On-Orbit Collisions: For each “duration” year and a fixed range of

Debris Impacts vs. Orbit Altitude altitude steps
[duration x 37]

Sci & Eng — On-Orbit Collisions: For each “duration” year and a user-entered

Debris Impacts vs. Debris Diameter list of altitudes
[duration x number of altitudes]

Sci & Eng — On-Orbit Collisions: For each “duration” year and a single user-

Debris Impacts vs. Start Date entered altitude
[60]




For further details and references, please see:

Krisko, P.H, “The New NASA Orbital Debris Engineering Model ORDEM 3.0,” AIAA/AAS
Astrodynamics Specialist Conference, San Diego, CA, USA, 4-7 Aug. 2014.
http://dx.doi.org/10.2514/6.2014-4227

Orbital Debris Engineering Models (ORDEM 3.0),
https://orbitaldebris.jsc.nasa.gov/modeling/engrmodeling.html (retrieved 29 Feb. 2016).

NASA Orbital Debris Engineering Model ORDEM 3.0 — User’s Guide, NASA/TP-2014-217370,
NASA Orbital Debris Program Office, NASA-JSC, Houston, TX, USA, April 2014.

C.4 Solar Flux Model

The value of the solar flux at a wavelength of 10.7 cm (2800 MHz), often called the F10.7 value, is
used as a measure of Solar activity. In DAS 2, the F10.7 value is used to compute the temperature,
and therefore density, of Earth’s upper atmosphere. In previous versions of DAS, the user entered a
single value of F10.7 for the given mission. In DAS 2, the user enters a starting date and a mission
length, and the software looks up the appropriate F10.7 values in an included data table. The table
includes historical values archived by the U.S. National Oceanic and Atmospheric Administration’s
(NOAA) Space Environment Center (SEC) (http://www.swpc.noaa.gov/), as well as the SEC’s
“near-term” predictions. For epochs beyond the near term, a curve-fit technique using sixth-order
sine and cosine terms was performed to fit historical daily solar flux values from 1947 through
September 2005. This curve-fit equation was then used to generate future flux predictions.

The DAS solar flux input table is updated periodically. The updated file should be downloaded
from the Orbital Debris Program Office Web site and placed in the DAS “data” directory.

For further information, see:
Whitlock, D.O., “Modeling the Effect of High Solar Activity on the Orbital Debris Environment,”

NASA Orbital Debris Quarterly News, vol. 10, no. 2, p. 4, April 2006.
(http://orbitaldebris.jsc.nasa.gov/newsletter/newsletter.html)

C.5 Human Casualty Expectation

Human casualty expectation is the product of the population density and the computed debris
casualty area. The probability of a surviving debris object striking a person on the ground is
defined as the reciprocal of the casualty expectation. Since DAS is typically concerned with objects
reentering years or even decades in the future, the population density must be treated statistically.
Therefore, the population density is averaged over longitude, and the population density along an
object’s ground-track is a function of its orbit inclination. The computed casualty area is a function
of the debris size and the size of an “average” person.
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http://orbitaldebris.jsc.nasa.gov/model/engrmodel.html

For further details and references, please see:
Opiela, J.N., and M.J. Matney, “Improvements to NASA's Estimation of Ground Casualties from

Reentering Space Objects,” Space Debris and Space Traffic Management Symposium, AAS
Science and Technology Series, vol. 109, p. 385-392, 2004.

C.6  Properties of the Default Materials

DAS includes a built-in list of the most common materials used in space vehicles. Three material
properties are used in assessment of an object’s reentry survivability: specific heat, heat of fusion,
and melt temperature. DAS also uses mass density to make sure a component’s mass and size are
consistent. The properties of the DAS built-in materials are listed in the table below. Note that the
specific heat of many of the materials is a function of the materials’ temperature.

Table C - 4: Properties of DAS 2 Built-In Materials

Material Description Specific Heat Heat of Melt Density
(J/kg-K) Fusion Temper- | (kg/m?3)
(J/kQg) ature (K)
Acrylic 1465 0.0 505.0 | 1170.00
Alumina 790.6 <Cp<1231.4 106757.0 2305.4 3990.00
Aluminum (generic) 1100 390000.0 850.0 2700.00
Aluminum 1145-H19 904 386116.0 919.0 | 2697.00
Aluminum 2024 - T3 972.7 386116.0 856.0 | 2803.20
Aluminum 2024-T8xx 845.3 < Cp < 1100.0 386116.0 856.0 | 2803.00
Aluminum 2219-T8xx 866.0 < Cp <1147.2 386116.0 867.0 2812.80
Aluminum 5052 900.2 386116.0 880.0 | 2684.90
Aluminum 6061-T6 896 386116.0 867.0 | 2707.00
Aluminum 7075-T6 846.8 <Cp < 1177.9 376788.0 830.0 | 2787.00
Barium element 285 55824.0 983.0 3492.00
Beryllium element 1675.4 < Cp <3594.8 | 1093220.0 1557.0 | 1842.00
Beta cloth 837.5 232.6 650.0 | 1581.00
Brass, Red (85% Cu, 15% Zn) 397.7<Cp< 410.3 195372.0 1280.0 | 8746.00
Brass, Cartridge (70% Cu, 30%2Zn) 397.7<Cp< 4145 179091.0 1208.0 | 8521.80
Brass, Muntz (60% Cu, 40% Zn) 397.7<Cp< 427.0 167461.0 1174.0 | 8393.67
Carbon-Carbon Reinforced 785.1 < Cp<1730.0 37650.0 2144.0 1688.47
Cobalt 412.4<Cp< 904.5 259600.0 1768.0 | 8862.00
Cork 1629.2 2860980.0 922.0 261.29
Cu alloy 389.4 <Cp< 471.8 204921.0 1356.0 | 8938.00
Cu/ Be (0.5% beryllium) 397 204921.0 1320.0 | 8800.00
Cu/ Be (1.9% berylium) 253.0<Cp < 652.0 204921.0 1199.0 | 8248.60
Fiberfrax 1130.5 0.0 2089.0 96.10
Fiberglass 1046.8 232.6 1200.0 | 1840.35
FRCI-12 (also LI-2200 w/ diff rho) shulttle tiles 705.3<Cp<1273.6 0.0 1922.0 192.22
Gallium Arsenide (GaAs) 325 0.0 1510.0 | 5316.00
Germanium 329.7<Cp< 397.7 430282.6 1210.7 | 5320.00
Gold element 126.4<Cp< 153.3 64895.0 1336.0 | 19300.00
Graphite epoxy 1 879 232.6 700.0 | 1550.50
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Table C - 4: Continued

Material Description Specific Heat Heat of Melt Density
(J/kg-K) Fusion | Temper- (kg/m3)
(J/kg) | ature (K)
Graphite epoxy 2 879 232.6 700.0 | 1550.50
Hastelloy ¢ (57% Ni, 15% Cr, 15% Mo, 5% Fe, 498.4<Cp < 694.6 309803.0 1620.0 | 8920.67
4% W)
Hastelloy 25 (aka Haynes alloy 25, 51% Co, 406.2 < Cp < 590.0 309803.0 1643.0 | 9130.00
20% Cr, 10% Ni, 15% W)
Hastelloy 188 (aka Haynes alloy 188, 42% Co, 406.2 < Cp < 590.0 309803.0 1635.0 | 8980.00
22% Cr, 22% Ni, 14% W)
Hastelloyn ( 71% Ni, 7% Cr, 16% Mo, 55% Fe) 419.0<Cp< 584.4 309803.0 1623.0 | 8576.40
Inconel x (aka x-750,Ni > 70%, 15% Cr, 7% 426.3<Cp< 541.8 311664.0 1683.2 8297.50
Fe)
Inconel 600 (Ni >72%, 15% Cr, 18% Fe) 426.7 < Cp < 650.2 297206.0 1683.9 | 8415.00
Inconel 601  (Ni 60%, 23% Cr, 13% Fe) 449.9<Cp< 815.9 311664.0 1659.0 | 8057.29
Inconel 625 (Ni >58%, 21% Cr, 9% Mo, 3% Nb) 410 311664.0 1593.0 | 8440.00
Inconel 718 (Ni 53%, 19% Cr, 17% Fe) 435 311664.0 1571.0 | 8190.00
Invar 479.9<Cp < 653.2 2740000.0 1700.0 | 8050.00
Iron (Armco) 433.7<Cp< 7115 272125.0 1812.0 | 7865.00
Lead element 130.5<Cp< 138.8 23958.0 600.0 | 11677.00
Macor ceramic 790 236850.0 1300.0 2520.00
Magnesium AZ31 (3% Al, 1% Zn) 1027.3 < Cp <1398.3 339574.0 868.0 | 1682.00
Magnesium HK31A (3% Th, 1% Zr) 1028.9 < Cp < 1340.6 325619.0 877.0 1794.00
Molybdenum 231.7<Cp< 412.0 293057.0 2899.0 | 10219.00
MLI 1046.6 232.6 617.0 772.48
MP35N (35% Ni, 33% Co, 20% Cr, 10% Mo) 440.0<Cp< 726.0 309803.0 1650.0 | 8430.00
Nickel 440.0<Cp< 726.7 309803.0 1728.2 | 8906.26
Niobium (a.k.a. columbium) 268.8 < Cp < 346.5 290000.0 2741.0 | 8570.00
NOMEX 1256 232.6 572.0 | 1380.00
Platinum 130.7 <Cp < 146.2 113967.0 2046.4 | 21448.70
Polyimide 1130 232.6 723.0 | 1420.00
Polycarbonate (Lexan) 1260 0.0 573.0 | 1250.00
RCG Coating 814.7 < Cp < 1633.7 0.0 1922.0 | 1665.91
Rene4l (52% Ni, 19% Cr, 11% Co, 10% Mo) 346.9 <Cp< 914.9 311664.0 1728.0 | 8249.00
Silver element 2226 <Cp< 243.7 105833.0 1234.0 | 10492.00
Sodium-lodide 84 290759.6 924.0 | 3470.00
Stainless Steel (generic) 600 270000.0 1700.0 7800.00
Steel 17-4 ph (Precipitation Hardening SS, Fe + 666.8 286098.0 1728.0 | 7833.03
17%Cr + 4%Ni+ 3-4%Cu alloy)
Steel 21-6-9  (Stainless Steel, 64%Fe+ 21% Cr+ 439 286098.0 1728.0 | 7832.80
6% Ni+ 9% Mn alloy)
Steel A-286  (Stainless Steel, 60% Fe + 15% Cr 460.6 286098.0 1644.0 | 7944.90

+ 25% Ni alloy)
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Table C - 4: Concluded

Material Description Specific Heat Heat of Melt Density

(J/kg-K) Fusion | Temper- (kg/m3)
(J/kg) | ature (K)

Steel AISI 304 (Stainless Steel, 69% Fe + 19% 482.0 < Cp < 608.2 286098.0 1700.0 | 7900.00

Cr + 10% Ni alloy)

Steel AISI 316 (Stainless Steel, 62% Fe + 18% 460.6 286098.0 1644.0 | 8026.85

Cr + 14% Ni alloy)

Steel AISI 321 (Stainless Steel, 69% Fe + 17% 565.2 <Cp < 651.2 286098.0 1672.0 | 8026.60

Cr + 11% Ni alloy)

Steel AISI 347 (Stainless Steel, 68% Fe + 17% 471.9<Cp< 638.0 286098.0 1686.0 | 7960.00

Cr + 11% Ni alloy)

Steel AISI 410 (Stainless Steel, 86% Fe + 13% 485.7 286098.0 1756.0 | 7749.50

Cr alloy)

Strontium element 737 95599.0 1043.0 | 2595.00

Teflon 1674 0.0 533.0 | 2162.50

Titanium (generic) 600 470000.0 1950.0 | 4400.00

Titanium (6 Al-4 V) 500.4 <Cp<1114.6 393559.0 1943.0 | 4437.00

Tungsten 127.1<Cp< 188.0 220040.0 3650.0 | 19300.00

Uranium 116.8<Cp< 201.1 52523.0 1405.0 | 19099.00

Uranium Zirconium Hydride (UZrH) 418.7 131419.0 21440 | 6086.80

Water 4081.1 < Cp < 6900.0 0.1 273.0 999.00

Zerodur 842.4 < Cp<1644.7 250000.0 1424.0 | 2530.00

Zinc 366.6 <Cp < 444.0 100942.0 692.6 | 7144.20
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